Fiery Color Profiler Suite Help
Contents

Fiery Color Profiler Suite ................................................................. 9
What’s new in this version ................................................................. 9
Dongle and license requirements for Color Profiler Suite ......................... 10
  Demo mode .................................................................................. 10
  Troubleshoot “Dongle not found” message ......................................... 11
  Troubleshoot “Dongle not licensed” message ..................................... 11
Download a Color Profiler Suite license ........................................... 12
Activate a Color Profiler Suite license ............................................. 13
Update Color Profiler Suite ............................................................ 13
  Set general preferences .................................................................. 13
    Automatically check for updates .................................................. 14
    Set dE calculation method preferences ....................................... 14
    Set the reference for test page control bar .................................. 14
    Set Color Profiler Suite version ............................................... 15
Calibrate the spectrophotometer ....................................................... 15

Fiery Express Profiler ................................................................. 16
Create calibration and profile in Express Profiler ................................ 16
Set Express Profiler preferences ................................................... 17

Fiery Printer Profiler ................................................................. 18
Profile a Fiery Server ................................................................. 18
Profile a Fiery XF server ................................................................ 19
Profile a remote, non-Fiery, or non-CMYK printer (Save as PDF) ............... 20
Select a printer for printing patch pages ........................................... 21
  Select a Fiery Server or Fiery XF server ....................................... 21
  Save patch pages as a PDF ......................................................... 22
Set up calibration ........................................................................ 22
  Set up calibration for a Fiery Server ........................................... 22
  Set up calibration for a Fiery XF server ....................................... 22
Print pages for calibration ............................................................ 23
Review calibration measurement results .......................................... 23
Print patch pages for profiling ...................................................... 23
Set patch options ........................................................................ 24
Fiery Device Linker .............................................................................................................. 41
    Optimize a device link (iterative match to a standard) ................................................ 41
    Optimize spot colors ................................................................................................. 42
    Select profiles to create a device link profile .......................................................... 43
      Select profiles for matching an industry standard ............................................... 43
      Select profiles for creating a custom device link profile ......................................... 43
    Specify profile settings in Device Linker ............................................................... 44
    Print patch pages for optimization ........................................................................ 44
    Check Device Linker measurement results and iterate .......................................... 45
    Save and install device link profiles ...................................................................... 45
    View device link profile information .................................................................. 46

Fiery Print Matcher ......................................................................................................... 47
    Create a common calibration and output profile .................................................... 47
      Create a new common calibration ........................................................................ 48
      Review calibration results .................................................................................. 48
      Create a common output profile ......................................................................... 48
    Update a common calibration .............................................................................. 49
    Create a new common device link profile ............................................................... 49
    Print calibration pages .......................................................................................... 50
    Print profiling pages ............................................................................................. 51
    Specify output profile settings ............................................................................. 51
      Set profile optimization ...................................................................................... 52
      Set viewing condition ........................................................................................ 52
    Specify device link profile settings ...................................................................... 52

Fiery Profile Inspector .................................................................................................. 54
    Display profiles ........................................................................................................ 54
      Work with profile models in Profile Inspector ..................................................... 54
      Set environment and display style for profile models ......................................... 56
    Display measurements from a file .......................................................................... 56
    Point information .................................................................................................... 57
    Measure a color with an instrument ..................................................................... 57

Fiery Profile Editor ....................................................................................................... 58
    Open a profile for editing ....................................................................................... 58
    Select rendering intent ......................................................................................... 58
Save a profile in Profile Editor ................................................................. 59
Output profile settings ........................................................................... 59
Reference image .................................................................................... 60
Reference image tools ......................................................................... 60
Open a reference image file ................................................................. 61
Select source profile to display reference image ................................. 61
Preview output media color .................................................................. 62
View source, original output, and edited output views ............................ 62
Display color information for a source color ......................................... 62
Set the color model for representing color values .................................. 62
Set method for calculating Delta E ....................................................... 63
Edit colors and the Edit List .................................................................. 63
Edit color globally ................................................................................ 64
Edit output curves ............................................................................. 64
Edit the colors in a hue ......................................................................... 64
Set hue and saturation of the output .................................................... 65
Select output hue using Profile Cross Section ...................................... 65
Edit a selected color ............................................................................ 66
Set hue, lightness, and chroma of the output color ............................... 66
Set color space coordinates .................................................................. 66
Select output color using Profile Cross Section .................................... 67
Edit a node ....................................................................................... 67
Highlight affected colors ...................................................................... 68
Set node and color coordinates ............................................................ 68
Select output node using Profile Cross Section .................................... 68
Adjust white point (media color) .......................................................... 69
Sample a color with a measuring instrument ........................................ 69

EFI Verifier .......................................................................................... 71
Verify color against a reference ............................................................ 71
Set Verifier preferences ........................................................................ 71
Set a reference preset ........................................................................... 72
Set a tolerance set ............................................................................... 72
Set print settings .................................................................................. 72

Fiery Auto Verifier .............................................................................. 74
Configure automatic test pages ............................................................. 74
Turn off automatic test pages ............................................................... 74
Measure test pages ................................................. 75
Record test results .................................................. 75

Fiery Color Verification Assistant ........................................ 77
Run verification tests .................................................. 77
View test results ....................................................... 78
Generate labels and reports .......................................... 78
Set Color Verification Assistant preferences ....................... 79
  Set printer and device tolerances .................................. 79
  Set color matching tolerances .................................... 80
Tests in Color Verification Assistant .................................... 80
  CMYK Verification test ........................................... 81
  RGB Verification test ............................................. 81
  Output Profile test ............................................... 81
  Printer Consistency test ......................................... 81
  Measurement Device test ....................................... 82
Job settings for color matching ........................................ 82
Status messages ...................................................... 82
Manage notifications .................................................. 83

Print and measure G7 targets .......................................... 84

Select a profile .......................................................... 85
Add and remove locations in the From list ......................... 85
Unlock a profile in Color Profiler Suite .............................. 85

Rendering intents ...................................................... 87

Add a Fiery Server .................................................... 88
Add a Fiery XF Server ................................................ 89
Fiery Color Profiler Suite

Fiery Color Profiler Suite lets you create a color profile that is fully compliant with International Color Consortium (ICC) standards. It can also evaluate, edit, and test color profiles.

Color Profiler Suite comes with an EFI ES-2000 Spectrophotometer, which is a measurement instrument used to create profiles. Other measurement instruments are supported as well.

Color Profiler Suite offers a number of modules.

These modules help you create profiles and calibrate a Fiery Server:

- **Express Profiler** - Creates a profile and calibration setting for a Fiery-driven printer, and creates a virtual printer or a preset that lets you print with the new calibration and profile right away. This is the fastest way to profile a Fiery-driven printer if you can accept the default profile settings.
- **Calibrator** - Creates a new calibration setting for a Fiery-driven printer or updates an existing one.
- **Printer Profiler** - Creates a profile of any RGB or CMYK printer, and can create new profiles from existing profiles. For Fiery-driven printers, a calibration setting can also be created. This module gives you full control over profile settings such as gamut mapping and separation.
- **Monitor Profiler** - Creates profiles of CRT and LCD monitors.
- **Device Linker** - Creates a device link profile and optimizes device link profiles and spot colors.
- **Print Matcher** - Creates profiles that match the color outputs of multiple Fiery-driven printers (each Fiery Server must run System 10 software or later).

These modules help you evaluate profiles:

- **Profile Inspector** - Displays three-dimensional models of RGB, CMYK, and Named Color ICC profiles in Lab color space, which lets you compare profiles.
- **Profile Editor** - Lets you edit output profiles. You can make global changes to an output profile or select specific areas to edit.
- **Verifier** - Lets you print and measure a patch page and compare the measured results to the expected results for a specific reference. Verifier can also compare any two sets of color values for quality control.
- **Auto Verifier** - Lets you print color test pages automatically and measure the pages for quality control.

Color Profiler Suite also includes:

- **Color Verification Assistant**, a utility for verifying a job's color output. You can open Color Verification Assistant in Command WorkStation, when Color Profiler Suite and Command WorkStation are installed on the same computer.
What’s new in this version

This version of Color Profiler Suite introduces new features.

Note: This version requires a new license. If you are upgrading from an earlier 4.x version and your SMSA (support) contract is current, Color Profiler Suite downloads a new license automatically from the EFI licensing server. If Color Profiler Suite cannot connect to the licensing server, see Download a Color Profiler Suite license on page 12.

- The Konica Minolta FD-9 spectrophotometer is now supported as a measurement instrument. This instrument can measure pages quickly and automatically.
- Calibrator is a new module that lets you create a new calibration setting for a Fiery Server or update an existing one (recalibrate the Fiery Server). This alternative to Calibrator in Command WorkStation supports many additional measurement instruments.
- G7 targets are available in FieryMeasure for printing and measuring.

Dongle and license requirements for Color Profiler Suite

Using Color Profiler Suite’s full functionality requires a spectrophotometer that has an activated license connected to the computer that has the software. (The spectrophotometer serves as a dongle.)

You can use any of the following instruments to license Color Profiler Suite:

- EFI ES-2000 (included with Color Profiler Suite). The EFI ES-2000 serial number is a 7-digit number on the EFI ES-2000 cradle and is part of the serial number on the EFI ES-2000 instrument.
- EFI ES-6000
- EFI ES-1000
- X-Rite i1 iSis
- Barbieri Spectropad (with USB connection only)
- Barbieri Spectro LFP
- Barbieri Spectro Swing
- Konica Minolta FD-5BT
- Konica Minolta FD-9

Note: Contact your EFI representative for more information about the EFI ES-6000 or the Konica Minolta FD-5BT.

An activated spectrophotometer license is valid for that spectrophotometer only, and you can use only that spectrophotometer with that license.

If you connect the spectrophotometer before starting Color Profiler Suite for the first time, Color Profiler Suite automatically downloads and installs the license when the application starts.

Note: If Color Profiler Suite cannot connect to the Internet, see Download a Color Profiler Suite license on page 12.

If you connect a spectrophotometer that is unlicensed, you must activate the license.

If no spectrophotometer is connected, or you do not want to activate the license, you can run in Demo mode.
**Demo mode**

If no licensed spectrophotometer is connected to the computer, Color Profiler Suite can run in Demo mode.

The following apply in Demo mode:

- Express Profiler, Monitor Profiler, Verifier, Auto Verifier, and Color Verification Assistant are unavailable.
- You cannot save profiles in Device Linker or Print Matcher.
- You can save profiles in Printer Profiler and Profile Editor only in a locked (.xcc) format. Locked profiles are usable only in Color Profiler Suite on the computer that saved them. You must use a licensed version of Color Profiler Suite on the computer to unlock the file. (Unlocking the file converts it to standard ICC profile format.)

**Troubleshoot "Dongle not found" message**

If no licensed spectrophotometer is connected when Color Profiler Suite starts, the "Dongle not found" window appears.

**Note:** If a licensed spectrophotometer is connected but the "Dongle not found" message appears, you may need to activate the Color Profiler Suite license.

- Click one of the following:
  - Download License - Downloads the license from the EFI license activation website. You can download the license from any computer that is connected to the Internet, even if Color Profiler Suite is not installed.
  - Activate License - Activates a license that is already on your desktop.
  - Run in Demo mode - Runs Color Profiler Suite in Demo mode.

**Troubleshoot "Dongle not licensed" message**

If a "Dongle not licensed" message appears and a spectrophotometer is connected, the license might not be available and activated.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>There was no Internet connection when Color Profiler Suite first started, so no license was downloaded.</td>
<td>If Color Profiler Suite started without an Internet connection, connect to the Internet, start Color Profiler Suite, and then click Download License.</td>
</tr>
<tr>
<td>You downloaded the license, but it is not on the computer’s desktop.</td>
<td>Move or copy the license to the computer’s desktop.</td>
</tr>
<tr>
<td>You have not activated the license.</td>
<td>If you already downloaded the license and the license file is on the desktop, click Activate License.</td>
</tr>
<tr>
<td>Problem</td>
<td>Action</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------</td>
</tr>
<tr>
<td>You have activated the license but it is for a different spectrophotometer than the one that is connected.</td>
<td>Connect the spectrophotometer associated with the license.</td>
</tr>
</tbody>
</table>
| Color Profiler Suite does not recognize the license although you are sure it is the correct license for your spectrophotometer. | Check that your license is valid for the version of Color Profiler Suite that is installed.  
  1. Open a browser and go to activation.efi.com/cps.  
  2. Enter the serial number or the License Activation Code, and then click Submit.  
  3. The version number that is shown must match the version number that appears when you select Help > About Fiery Color Profiler Suite in the Color Profiler Suite main window. |

If you want to use Color Profiler Suite with no license or no spectrophotometer, click Run in Demo Mode.

### Download a Color Profiler Suite license

Your computer downloads a license from the Internet. If the computer has no Internet connection, you can download the license from another computer and move it to the computer that has Color Profiler Suite installed.

To download the Color Profiler Suite license, you must have the serial number of a valid dongle or a License Activation Code. For a list of measurement instruments that can be used as a dongle, see Dongle and license requirements for Color Profiler Suite on page 10.

The License Activation Code is on the license card in the Color Profiler Suite media pack.

1. Do one of the following:
   - In the Color Profiler Suite main window, click Help > Download License.
   - Open a browser and go to activation.efi.com/cps.

2. After the EFI License Fulfillment page opens, enter the serial number or the License Activation Code, and then click Submit.

   **Note:** If you use the EFI IS-2000 serial number, enter only the 7-digit string shown on the cradle. Omit the other numbers that are part of the serial number on the instrument.
3 Do one of the following:
   • Save to File - Saves the license to the specified location.
     **Note:** The license file must be on the desktop for activation to occur. After activation, Color Profiler Suite copies the file to a location on your hard disk.
   • View License File - Lets you view the license file, and then save it or send it in an e-mail message.
   • Send by email to - Sends the license to the email address you enter. (This is useful if you want to use Color Profiler Suite on another computer.)

4 If you want to use Color Profiler Suite on a computer that has no Internet connection, copy the license file to portable media and then copy the license file to the other computer’s desktop.

**Activate a Color Profiler Suite license**

The downloaded Color Profiler Suite license file must be on the computer’s desktop for activation. To activate the license on that computer, you must connect the correct spectrophotometer. If no spectrophotometer is connected, the Demo mode message appears.

If your computer has no Internet access, you must copy the license file to the desktop of the computer that has Color Profiler Suite installed.

1 Connect the licensed spectrophotometer to the computer.
2 Do one of the following:
   • In the Color Profiler Suite main window, click Help > Activate License.
   • Click Activate License in the Dongle Not Licensed window.

**Update Color Profiler Suite**

The Color Profiler Suite Updater checks for updates and lets you download and install them. You can also schedule checking for updates every time you start Color Profiler Suite, monthly, or never.

**Note:** To qualify for upgrades that add new features, Color Profiler Suite requires a current Software Maintenance and Support Agreement (SMSA). Your SMSA renewal date is displayed in the Color Profiler Suite Updater. If your SMSA is expired, click Renew Now to renew your SMSA.

If the Updater finds an update, you can download and install it.

1 Click Help > Check for Updates.
2 If you want to schedule automatic checks for updates, click Every time, Monthly, or Never.
3 If you want to check for updates now, click Check Now.
4 To install an update, click Download and Install and follow the on-screen instructions.
Set general preferences

The General tab lets you set preferences that apply to all modules of Color Profiler Suite.

Automatically check for updates

The Updater checks for updates of the software and documentation on the EFI web site and allows you to download and install them. You can set a preference to determine how often the Updater runs.

1 In Color Profiler Suite, click Edit > Preferences.
2 Click the preferred frequency in the Automatically check for updates list.
   - Every time - The Updater runs whenever you open Color Profiler Suite.
   - Monthly - The Updater runs whenever you open Color Profiler Suite if more than a month has passed since the last check.
   - Never - The Updater does not run automatically. You can run the Updater manually.

Set dE calculation method preferences

There are many ways to calculate dE, the numerical difference between two colors. You can use the Preferences tab to set how Color Profiler Suite calculates dE. (People also refer to dE as Delta E, also written as ΔE.)

Tolerance values are in units of dE and the calculation method: for example, 0.5 dE 94.

You can set which method Color Profiler Suite uses to interpret all dE values that you specify in Color Profiler Suite.

1 In Color Profiler Suite, click Edit > Preferences.
2 Click one of these calculation methods in the dE Calculation Method list:
   - dE ab - The standard CIE method. The color difference is the distance between the two colors, calculated in three-dimensional Lab color space.
   - dE 94 - A variant of CIELAB that CIE TC1-29 recommends as the color difference formula. For graphic arts applications, this method uses $K_1 = 0.045$ and $K_2 = 0.015$.
   - dE 2000 - A variant of CIELAB that CIE recommended in 2000. This method uses $KL = KC = KH = 1.0$.
   - dE CMC - The ratio of differences in lightness to chroma and to hue calculated using the ISO standard ISO 105-J03. Values for lightness and chroma weights are 1.0 for use with perceptibility data.
Set the reference for test page control bar

In Fiery Color Profiler Suite, you can print a test page to check your results. For example, when you create a new profile, you can print a test page using the new profile. The CMYK reference used for the control bar on the test page is set in Preferences. You can choose from several international references.

1. In Color Profiler Suite, click Edit > Preferences.
2. Click the reference in the Control bar definition list.

Set Color Profiler Suite version

If your computer has multiple versions of Color Profiler Suite installed on your computer, you can set which version to use when you open Color Profiler Suite from Command WorkStation.

When Command WorkStation and Color Profiler Suite are installed on the same computer, you can open a Color Profiler Suite module from within Command WorkStation to perform various tasks. For example, you can select a job in Command WorkStation and open Fiery Color Verification Assistant to perform color verification of the job.

If multiple versions of Color Profiler Suite are installed on your computer as well as Command WorkStation v5.4 or later, you can set an option in Color Profiler Suite to determine which version of Color Profiler Suite to open.

Note: A message appears when you open Color Profiler Suite from Command WorkStation for the first time.

1. In Color Profiler Suite, click Edit > Preferences.
2. Click the preferred version in the list.

Calibrate the spectrophotometer

For reliable measurements, you must calibrate the spectrophotometer before measuring. You cannot continue with the measurement if you cannot calibrate the spectrophotometer successfully.

Note: This procedure applies to the EFI ES-1000 or the EFI ES-2000 spectrophotometer.

1. Place the spectrophotometer in its cradle, and then press the button on the spectrophotometer or click Calibrate on the screen.
2. If calibration fails, make sure the white tile on the cradle is uncovered and the white tile and instrument aperture are clean, and then repeat the calibration.

If calibration succeeds, you can continue with your measurements.
Fiery Express Profiler

With Express Profiler, you can quickly create a calibration setting and an output profile for a printer connected to a Fiery Server. Express Profiler also creates a virtual printer or server preset configured with the new output profile so that you can immediately print a job using the new output profile.

**Note:** If the Fiery Server runs System 10 software or later, Express Profiler creates a server preset. Otherwise, Express Profiler creates a virtual printer.

Express Profiler does not run in unlicensed (Demo) mode.

Create calibration and profile in Express Profiler

To create a calibration and an output profile, you specify the Fiery Server and then print and measure a calibration page and a profiling measurement page.

Settings for printing the calibration and profiling measurement pages are set in Preferences. Check these settings the first time that you use Express Profiler and change them if necessary.

1. In Color Profiler Suite, start Express Profiler.
2. In the Welcome window, click **Select Fiery Server** and select the Fiery Server from the list. If the Fiery Server is not in the list, click the plus sign to add it using the IP address or by searching.
3. Type a name for **Description** and click **Next**. This name will be used for the calibration, the output profile, and the virtual printer or server preset that you will create.
4. Select any job settings needed to print the warm-up pages and the calibration page and click **OK**. The same job settings will be used to print the profiling measurement page.
5. Click **OK**, retrieve the pages from the printer, and follow the on-screen instructions to measure the calibration page. A new calibration setting is created.
6. Click **OK**, retrieve the profiling measurement page from the printer, and follow the on-screen instructions to measure the page. After you finish measuring the page, the profile is created and installed on the Fiery Server.
7. Click **Test Print** to print a test page using the new profile.
8. Click **Done**.

A virtual printer or server preset with the same name as the output profile is created. To print a job using the new output profile and calibration setting, print to this virtual printer or apply the server preset to the job.
Set Express Profiler preferences

The Express Profiling tab lets you set how the calibration and profiling measurement pages are printed in Express Profiler. When you configure these settings before profiling, you do not need to select them each time you create a profile.

1. In Color Profiler Suite, click Edit > Preferences.
2. In the Express Profiling tab, select the settings.
3. Click the measurement instrument in the Instrument list.
   If you want to make specific settings for the measurement instrument, click Settings.
4. Click a patch layout in the Profiling patch layout list.
   ICC standard targets are the basis for some of the common patch layouts:
   - 46 - Provides the fastest profiling method using a handheld instrument. With this layout, additional data is mathematically calculated to ensure the quality of the resulting profile.
   - 234 - Is fast to use and produces high-quality results with most printers that have a smooth color response.
   - 928 - Produces high-quality results on most printers. If you are unsure of your printer’s color response, use the 928-patch layout to ensure higher quality.
   - 1485 or 1485 random - Comes from the European Color Initiative and incorporates two versions of IT8 targets. The random layout helps to reduce potential bias caused by color variation across the page.
   - 1617 or 1617 random - Are similar to the 928-patch layouts but provide more data. The random layout helps to reduce potential bias caused by color variation across the page.
   - 4028 - Provides maximum color precision, the same level of precision as factory-supplied profiles from EFI.
5. Click a patch layout in the Calibration patch layout list.
   A greater number of patches yields more measurement data, which may produce better results. However, more patches take longer to measure.
   Sorted patches are printed on the page in the order of their hue and saturation levels. Random patches are printed on the page in random order, to help compensate for density inconsistencies on different areas of the page.
6. Click a paper size in the Paper Size list, or click Custom to set a custom page size.
7. To print warm-up pages before printing the calibration page, specify Number of warmup pages.
   A warmed-up printer usually prints more consistently. If the printer has been idle, print 5-10 warm-up pages.
8. Select Maximum GCR if you want the new profile to be saved with the Maximum GCR setting.
   Maximum GCR automatically sets the separation (black control) settings to maximize the GCR (gray component replacement) of the profile. It can help to improve the gray balance of prints, achieve better compliance with industry color standards, and maximize the output gamut.
Fiery Printer Profiler

Fiery Printer Profiler can create custom output profiles for most RGB and CMYK printers: Fiery-driven, Fiery XF server-driven, Splash-driven, inkjet, non-Fiery, and printing presses. Use Printer Profiler with a measurement instrument (such as the spectrophotometer included with Color Profiler Suite) to create an output profile to describe the gamut, or range of reproducible color, of a printer.

The profiles created are fully compliant with International Color Consortium (ICC) standards, so that you can use them with industry standard applications and platforms. You can create a new calibration setting before profiling. You can choose to print patch pages and measure them immediately or later. With Printer Profiler, you can also import existing measurements, from files or ICC profiles, and modify the gamut mapping and black controls before saving a new profile.

To generate a profile, you print pages of color patches (to show the color behavior of a printer), measure the patches, and then create a profile using the measured values. You can start Printer Profiler at any point in this process.

- **Print Patches** - Start here if you want to create a new profile and optionally, a new calibration setting, and have not printed a patch page.
- **Measure Profiling Patches** - Start here if you have patch pages that were printed earlier or on a printer at another location. Using a measurement instrument, record spectral measurements of each color patch.
- **Convert Measurements to Profile** - Start here if you want to import measurements from an IT8 file that contains spectral or colorimetric data or from an existing ICC profile. Apply gamut mapping and separation settings to create an ICC profile that describes the gamut of your printer.

Profile a Fiery Server

You can create a profile for a printer connected to a Fiery Server. The Fiery Server must be accessible from your computer over the network.

1. In Color Profiler Suite, start Printer Profiler and click **Print Patches**.
2. In the Welcome window, type the new profile name and select the Fiery Server from the list.
   - If the Fiery Server is not in the list, click the plus sign to add it using the IP address or by searching.
   - Depending on the Fiery Server that you select, you may also be able to select the color space of the new profile. The printer must be already configured for the color space that you select.
3 For calibration, click the appropriate option.
   • Create new calibration setting - If you are profiling a new paper type for the Fiery Server.
   • Use existing calibration setting - If you are profiling a paper that is very similar to a paper whose output profile already exists on the Fiery Server. In this case, select the calibration setting that is associated with that profile.
     Select Skip calibration only if this calibration setting is up-to-date. (The Fiery Server was calibrated recently for this calibration setting.) In this case, go to step 8 on page 19.

   **Note:** If the Fiery Server does not support calibration, skip this step and go to step 8 on page 19.

4 Select the instrument, patch layout, and paper size for printing the calibration page. We also recommend warming up the printer by printing at least 10 warmup pages.

5 Specify print settings and click OK.
   Specify settings that affect color, such as halftone, but do not change any settings on the Color tab. The calibration page and the profiling page will be printed with the same settings.

6 Retrieve the pages from the printer and follow the on-screen instructions to measure the calibration page.
   (Discard any warmup pages.)

7 View the measurement results and click Next.

8 Select the instrument, patch layout, and paper size for printing the profiling measurement pages.
   If you want to measure multiple sets of pages and then average the measurements into one set of data for creating the profile, specify the number of page sets to print.

9 Retrieve the measurement pages from the printer, follow the on-screen instructions to measure them, and then save the measurements.
   **Note:** If the printer measures the pages automatically, you can skip this step.

10 In the Summary window, check the results.
   Click Average measurements to view all measurement sets and proceed to measuring the next set, if any.

11 In the Apply Settings window, select the profile settings or import settings from an existing profile.
   **Note:** The available settings depend on the capabilities of the printer.

12 In the Save Profile window, specify the desired settings. Confirm that Install on Fiery Server is selected and that the correct Fiery Server is selected.
   The profile is created when you click Next.
   The profile is installed on the Fiery Server.

**Profile a Fiery XF server**

You can create a profile for a printer connected to a Fiery XF server. The Fiery XF server must be accessible from your computer over the network.

For more information about Fiery XF servers, see the documentation that accompanies Fiery XF.

1 In Color Profiler Suite, start Printer Profiler and click Print Patches.
2 In the Welcome window, click Select XF Server and select the Fiery XF server from the list. Under Printer description, select the printer to profile.

   If the server is not in the list, click the plus sign to add the server using the IP address or by searching.

3 Select ink, media, and calibration set appropriate for the printer and the paper that you are using.

4 Select the settings for creating the measurement pages.

   • If desired, click Settings to select the settings for the measurement instrument.

   • If desired, for a four-color (CMYK) printer, click Expert Settings to adjust the maximum densities for CMYK. For printers that support more than four colors, click Expert Settings to adjust the settings for the additional colors.

5 Save the measurement page ID.

6 Specify print settings and click Print.

7 Retrieve the measurement pages from the printer and follow the on-screen instructions to measure the measurement pages.

8 Save the measurements.

9 In the Summary window, check the results.

   Click the Help icon for more information about inspecting measurements and averaging measurements.

10 In the Apply Settings window, select the profile settings or import settings from an existing profile.

11 In the Save Profile window, specify the desired settings and confirm that Install on XF Server is selected.

   The profile is created and installed on the Fiery XF server.

Profile a remote, non-Fiery, or non-CMYK printer (Save as PDF)

You can profile a printer that is not connected to a Fiery Server or Fiery XF server or that has a color space other than CMYK by using the Save as PDF option.

Instead of printing the patch pages in Printer Profiler, you save them to a PDF file. You must print the PDF file manually before you can measure the patch pages in Printer Profiler.

1 In Color Profiler Suite, start Printer Profiler and click Print Patches.

2 In the Welcome window, click Save as PDF and select the color space of the printer.

3 Select the instrument, patch layout, and paper size for creating the measurement pages.

   If desired, click Expert Settings to adjust the maximum densities for the colorants and the patch object type for CMYK or RGB.

4 Save the measurement page ID.

5 Save the PDF file.

   The file is saved in My Documents\Fiery Color Profiler Suite 4\Patch Pages (Windows) or Documents /Fiery Color Profiler Suite 4/Patch Pages (Mac OS X).
6 Print the PDF file on your printer and retrieve the measurement pages.

7 Return to Printer Profiler and follow the on-screen instructions to measure the measurement pages.

8 In the Summary window, check the results.

9 In the Apply Settings window, select the profile settings or import settings from an existing profile.

10 In the Save Profile window, specify the desired settings.

11 Select Save on local drive.
   The profile is created when you click Next.

Select a printer for printing patch pages

To create a profile, you print patch pages to measure. To profile a non-Fiery printer or a printer that is not connected to your computer, you can save the pages as a PDF and print them outside of Printer Profiler.

- If you select a Fiery Server, Printer Profiler retrieves the manufacturer, model, and color space from the Fiery Server. Printer Profiler also retrieves other settings used in creating the profile.

   The Color Space setting is the printer’s preferred color space for creating an output profile. If you are creating a profile to simulate the output of another printer, you may want to set the color space of the printer that you are simulating. If your printer supports more than one color space, select the color space for the profile. The printer must be already configured for the color space that you select.

- If you set a Fiery XF server, you must also specify a printer that is set up in Fiery XF. (A Fiery XF server can have multiple printers connected to it.) Printer Profiler also retrieves other settings used in creating the profile from the Fiery XF server.

   If the printer is not the linearization device, the printer settings automatically transfer to the linearization device. The linearization device is the printer that is always used for profiling in Fiery XF.

   If your printer is not in the list, make sure that the EFI Media Profiles folder contains an appropriate base linearization file (*.EPL). You can create a new base linearization file for your printer in Fiery XF Color Tools, if necessary.

- If you save the file as PDF, you set CMYK or RGB as the printer color space.

Select a Fiery Server or Fiery XF server

You can set a printer that has a connection to a Fiery Server or Fiery XF server.

1 In Color Profiler Suite, start Printer Profiler and click Print Patches.

2 In the Welcome window, click Select Fiery Server or Select XF Server and then click a server in the list.

   If you click Select Fiery Server, the list contains recently selected servers connected through Command WorkStation (if Command WorkStation is installed on your computer).

3 If the Fiery Server or Fiery XF server does not appear in the list, click the plus sign (+) and select a server from the network.
4 In the Printer description area, confirm the settings that appear or select new setting from the list.

**Save patch pages as a PDF**

Saving patch pages as a PDF lets you print them later or print them from a printer that is not on your network.

1 In Color Profiler Suite, start Printer Profiler and click **Print Patches**.
2 In the Welcome window, click **Save as PDF**.
3 In the **Color Space** list, click the color space of the printer you are profiling.

**Set up calibration**

Printer Profiler lets you set the type of calibration for the printer that you are profiling. Some printers use the printer’s current calibration state and require no calibration setup.

**Set up calibration for a Fiery Server**

Fiery calibration uses a calibration that specifies the target density values (the calibration target) for a Fiery Server.

For best results, when you create a new profile, create a new calibration setting to be used with the new profile. It will include a calibration target based on the current state of the printer.

If you do not create a new calibration setting, you can use an existing calibration with the new profile, but only if the paper that you are profiling is very similar to paper of the existing calibration. For example, if the new paper is a coated, heavy paper, the existing calibration must be for a coated, heavy paper. If the paper is not very similar, the calibration target is not appropriate for the paper.

- In the Calibration Setup window, click one of the following:
  - **Create new calibration setting** - Prints and measures a set of patches without calibration applied and calculates an appropriate calibration target. In this case, the new profile is associated with the new calibration setting.
  - **Use existing calibration setting** - Uses the selected calibration setting to print and measure patches, unless you select **Skip calibration**. In this case, the new profile is associated with the selected calibration setting. Skip calibration only if the calibration is up-to-date.
Set up calibration for a Fiery XF server

When you profile a printer connected to a Fiery XF server, you specify the ink type, media name, and the calibration set (base linearization).

- In the Calibration Setup window, set the following:
  - Ink type - If the printer supports more than one type of ink, set the ink type for profiling.
  - Media name - Sets the combination of media type and calibration set. A calibration set specifies a base linearization file that is associated with a media profile.
  - Calibration set - Set print conditions that adjust the printer behavior to the media.
    Print conditions include resolution, halftone settings, color mode, print direction, and media profile. You must specify a calibration set because a media name can be associated with more than one calibration set.

Print pages for calibration

The Calibration print settings window lets you specify calibration pages.

Color patches are printed on the calibration page according to the measurement instrument, layout, and paper size that you specify. You can also set the number of warmup pages to print. (Warmup pages are extra pages that you can discard.)

A greater number of patches yields more measurement data, which may produce better results. However, more patches take longer to measure.

- Sorted patches are printed on the page in the order of their hue and saturation levels.
- Unsorted patches are printed on the page in random order, to help compensate for density inconsistencies on different areas of the page.

1. Select the Instrument, Patch layout, and Paper size to use for printing the calibration page.
2. (Optional) To make specific settings for the instrument, click Settings.
3. Click Set number of warmup pages and then set a number.

Review calibration measurement results

After taking calibration measurements, you can review the resulting maximum density (D-Max) values of the calibration target.

1. Review the calibration results, and click Next.
2. If any results are questionable, click Reprint next to the results to reprint and remeasure a calibration page.
Print patch pages for profiling

To create a profile in Printer Profiler, you must specify print options and other settings for sending the patch pages to the printer.

If you plan to print multiple sets of patch pages and average the measurements, you can specify the number of sets. (You can use the average of the measurements to create the profile.)

You are prompted to save the ID for the measurement pages before printing. You can change the file name, but do not change the folder location. The Patch ID is assigned to and printed on the patch pages.

**Note:** Before you print the pages, you can specify other print settings, such as media and halftone. Do not change any color management settings.

1. Connect the measurement instrument to your computer.
2. In the Print Settings window, click the measurement instrument in the Instrument list.
3. If you want to make specific settings for the measurement instrument, click Settings.
4. Click a patch layout in the Patch Layout list.

   ICC standard targets are the basis for some of the common patch layouts:
   
   • 46 - Provides the fastest profiling method using a handheld instrument. With this layout, additional data is mathematically calculated to ensure the quality of the resulting profile.
   • 234 - Is fast to use and produces high-quality results with most printers that have a smooth color response.
   • 928 (IT8.7/3) - Produces high-quality results on most printers. If you are unsure of your printer’s color response, use the 928-patch layout to ensure higher quality.
   • 1485 (ECI 2002) or 1485 random (ECI 2002) - Comes from the European Color Initiative and incorporates two versions of IT8 targets. The random layout helps to reduce potential bias caused by color variation across the page.
   • 1617 (CGATS IT8.7/4) or 1617 random (CGATS IT8.7/4) - Are similar to the 928-patch layouts but provide more data. The random layout helps to reduce potential bias caused by color variation across the page.
   • 4028 - Provides maximum color precision, the same level of precision as factory-supplied profiles from EFI.

   **Note:** To use a patch layout that is not available in Printer Profiler, you can print and measure patch pages with Verifier and then import the measurements in Printer Profiler.

5. Click a paper size in the Paper Size list, or click Custom to set a custom page size.

   In Fiery XF, the media size is set up for the printer in System Manager.

6. Click Expert Settings to specify settings for the patches:

   • If you are creating a CMYK profile, you can change the ink or toner limits on your printer and specify the object type for the patches.
   • If you are creating an RGB profile, you can specify the object type for the patches.

7. To print multiple sets of patch pages and measure them, specify Number of sets.
8. Click Next and save the ID for the measurement pages.
Set patch options

Before you print patches, you can set options such as ink limits and the patch object type. The options you can set depend on the type of profile you are creating: CMYK, CMYK with additional colors, or RGB.

For a CMYK profile, you can set options for ink or toner limits and the patch object type. For a profile for CMYK plus additional colors, you can set options for handling the additional colors. For an RGB profile, you can set the patch object type.

- If you profile a Fiery-driven printer connected to the network, the Fiery Server provides the default settings for these options.
- If you profile a Fiery XF-driven printer, Printer Profiler extracts the settings from the base linearization file. We recommend that you do not change these settings.

Set ink and toner for profiles

You can set ink and toner for profiles for CMYK only and profiles for CMYK plus additional colors.

1. In the Print Settings window, click Expert Settings.

2. To create a profile for CMYK, set the ink or toner limits for printing patch pages.

   **Note:** We recommend that you print with the default values unless your printer has problems printing with those levels.

3. To create a profile for CMYK plus additional colors, set how the additional colors are added to CMY and how the transition from CMY to the additional colors occurs.

   For each additional color, you can set ink or toner limit, purity (amount of CMY that is retained at the maximum coverage), and a gamma value for the tonal value increase.

   **Note:** Ink or toner limits for CMY are not adjusted when the printer supports additional colors.

Set object type for patches

For a CMYK or an RGB profile, you can set the patch object type as either bitmap or vector graphics. We recommend that you keep the default setting (bitmap images).

**Note:** Be sure to print the patches using the same object type as the actual jobs you will print using the profile that you are creating.

1. In the Print Settings window, click Expert Settings.

2. Under Create Patches As, click one of these object types:

   - **Bitmap images** - Sets image objects with color behavior similar to Adobe Photoshop images.
   - **Vector graphics** - Sets vector graphics with color behavior similar to Adobe Illustrator or Adobe Freehand illustrations.
Use a patch ID to select a patch page to measure

Each set of patches receives a tracking ID that lets you set which patch pages to measure. (The ID is printed on the patch pages.) The tracking ID uniquely identifies the set, including all profile information and whether it contains one page or more.

If you already have patch pages to measure when you start Printer Profiler, you can proceed directly to measuring the patch pages. In this case, you must select the patch page ID from a list that contains recently assigned Patch IDs. Information for the selected Patch ID appears in the Patch settings field. You can check that a patch ID is correct by checking the date and time that appear with the patch settings.

If the patch ID does not appear in the list, you can create a new patch ID. The patch ID may not appear in the list for one of the following reasons:

- You already measured the patch pages and created the profile. Printer Profiler removes the Patch ID from the list after measuring and saving the corresponding patch pages.
- You created the patch pages in another application or on another computer.
- You deleted the patch page files before measuring them or saving the measurements.
- The first time you use Printer Profiler, no patch pages have been created.

Note: Alternatively, if the patch page ID does not appear in the list, you can measure the patch pages in another application, save the measurements as an IT8 file, and import the measurements into Printer Profiler.

Select the patch ID for your patch pages

To measure a set of patch pages, you first select a patch ID.

1. In Color Profiler Suite, start Printer Profiler and click Measure Profiling Patches.
2. Click the patch ID in the list.

Create a new patch ID if no ID exists for your patch pages

You can create a new patch ID for existing patch pages by starting to print another set of patch pages and then canceling the print job.

1. In Color Profiler Suite, start Printer Profiler and click Print Patches.
2. Select the printer that matches the name printed on the patch pages and click Next.
3. Click Next to accept the default calibration.
4. Select the instrument, patch layout, paper size, and number of sets to match the information on the patch pages.
5. Click Expert Settings and choose the settings that match the information on the patch pages.
6. Click Next and save the measurement page ID.
7. In the Job Properties window, click Cancel.
8. Click Cancel in the Print Settings window.
In the Printer Profiler main window, click **Measure Profiling Patches**. The Patch ID that you created appears in the Patch ID list.

**Remove a Patch ID from the list**

You delete a patch ID by deleting its corresponding file.

1. In Color Profiler Suite, start Printer Profiler and click **Measure Profiling Patches**.
2. Click **Manage patch page list** in the Select Patch ID list.
3. Delete the corresponding file from the folder.

**Import measurements for creating a profile**

If you already have measurements in either an IT8 file or an existing ICC profile, you can use those measurements to create a profile. This is a simple way to update an existing profile’s settings without changing its measurement data.

You can import measurements from one or more IT8 files or from a single profile. If you import measurements from more than one file, Printer Profiler uses the average of the imported measurement sets to create the profile. You may want to use the average of multiple measurements if printer output is inconsistent or to create a common profile for multiple printers.

If the import measurements are in the wrong format, a warning appears. The measurement file or files do not contain enough information to create a valid profile. The files must meet these requirements:

- Measurement files must conform to the CGATS.17 format.
- All of the files together must contain a sufficient number of measurements.

**Import measurements from one or more IT8 files**

You can import measurements from one or more IT8 files.

1. In Color Profiler Suite, start Printer Profiler and click **Convert Measurements to Profile**.
2. Click **Measurement File**, and then click **Next**.
3. Select one or more files, and then click **Open**.

**Import measurements from an ICC profile**

If you import measurements from an ICC profile, you can import from only one ICC profile at a time. You cannot average the measurements from two ICC profiles.

1. In Color Profiler Suite, start Printer Profiler and click **Convert Measurements to Profile**.
2 Click ICC Profile, and then click Next.

3 Click the file, and then click Select.

4 If the Missing Information window appears, do one of the following:
   • If you know the manufacturer or model, specify the manufacturer and model for the printer associated with the profile.
   • If you do not know the manufacturer or model, specify the generic settings.

Summary of measurements

After measurement data is available, the Summary window displays a summary of information about the measurements and the conditions used to create them. The dE (Delta E) values in the Average Measured Variation or the Maximum Measured Variation fields summarize the variation in measurements of the same color.

If a dE value is displayed in red, it is because the variation appears to be significant. The variation does not necessarily indicate an error, but consider these values for realistic expectations. Your profile cannot be any more accurate than what has been measured.

You may want to produce some test prints to check that the output of your printer is behaving as you expect.

You can also:

• Check for potential problems with the measurement data by viewing the color space that the measurements represent in Profile Inspector.

• View a list of multiple sets of measurement values and add or delete measurement sets to include in the average.

Choose data for averaging measurements

If you have sets of measurements from multiple sets of patch pages, Printer Profiler calculates an average of the measurements to create the profile. You can add or remove measurement sets to include or exclude the data in the average.

1 In the Summary window, click Average measurements.

2 Do one of the following:
   • To add a file to the list, click Import measurement, browse to select the file, and then click Open.
   • To remove a file, deselect the check box next to the file in the list.
Apply profile settings

After you make or import measurements in Printer Profiler, the Apply Settings window lets you set the profile’s gamut mapping, separation settings, profile optimization, and viewing condition. You can also load existing settings from a preset (saved settings) or from a profile.

Note: The available settings vary, depending on the capabilities of the printer.

Load existing settings

If you want, you can apply the settings from an existing profile or choose an existing preset (saved settings).

1 In the Apply Settings window, click a profile in the Settings list or click one of these presets:
   - Generic CMYK - Default settings for a CMYK printer
   - EFI VUTEk TX3250r Direct Print - For VUTEk direct media
   - EFI VUTEk TX3250r Transfer Print - For VUTEk transfer media
   - Inkjet Default - For lowest dE (Delta E) when profiling an inkjet printer. This is for a profile used for printing proofs.
   - Toner - Generic black generation for lowest dE when profiling a toner-based printer.

2 If a profile does not appear, click Import Settings in the Settings list to locate and select the profile.

Set maximum GCR

The Maximum GCR option automatically sets the separation (black control) settings to maximize the GCR (gray component replacement) of the profile.

Maximum GCR can help to improve the gray balance of prints, achieve better compliance with industry color standards, and maximize the output gamut.

- In the Apply Settings window, click Maximum GCR.

Set profile optimization

The Optimize colorimetric precision option uses optimization to improve colorimetric precision and reduce dE (Delta E) values.

Increasing colorimetric precision can result in less smooth color transitions. Use this option for profiles that are used for printing proofs or for press certification but not for production workflows, where color perception is more important than precision.

- In the Apply Settings window, click Optimize colorimetric precision.
Set viewing condition

You can set the color of ambient light used when obtaining color measurements.

- In the Apply Settings window, do one of the following:
  - Click a setting in the Lighting value list.
  - Click the plus sign (+) to create your own setting, either by using a measurement instrument or by specifying the XYZ value.

Set gamut mapping

An output profile contains information for different types of gamut mapping with different rendering intents. Gamut mapping settings control how gamut mapping occurs.

The Edit Gamut Mapping window displays the colormetric mapping, saturation blending, and perceptual mapping used for gamut mapping. These settings apply to both RGB and CMYK profiles.

- Colorimetric mapping applies to the Absolute Colorimetric and Relative Colorimetric rendering intents. It determines how an output color is matched to a source color.
- Saturation blending applies to the Saturation rendering intent.
- Perceptual mapping applies to the Perceptual rendering intent.

The default settings for the gamut mapping options are recommended for most profiles.

1 In the Apply Settings window, click Edit Gamut Mapping.

2 Click one of the following in the Colormetric Mapping list:

   - Closest dE (Delta E) - Sets the output color value that is closest to the source color value numerically. This setting generally produces the most visually appealing color.
   - Closest dE Enhanced Shadows - Sets the output color value that is closest to the source color value numerically, except that it adjusts color values in shadow regions to provide smoother gradations. This setting may enhance results when profiling on media with a small gamut.
   - Constant Hue - Sets the output color value closest to the source color value in the same hue. This setting might produce more desirable output than Closest dE. For example, a blend from pure white to pure blue is smoother with this setting. Photographic images with a wide range of sky blue tones also reproduce better.

3 Click one of the following in the Saturation Blending list:

   - Enhance Gamut Blending - Generates smooth transitions through the entire gamut, making larger adjustments for colors farther from the neutral axis.
   - Use Presentation Method from EFI Profiler 1.5 - Preserves continuity if you have used EFI Color Profiler v1.5 to create profiles and want to match the profile you are creating now with your existing profiles.
   - CIECAM saturation - Produces more natural colors when using the Saturation rendering intent, based on the latest CIE color appearance model.
4 Click one of the following in the Perceptual Mapping list:

- EFI Photographic - Matches Fiery workflows.
- Perceptual - Standard ICC mapping.
- CIECAM presentation - Produces more natural colors when using the Presentation rendering intent, based on the latest CIE color appearance model.

Specify separation settings

Separation settings control how to handle black in the output. You can edit black controls for CMYK profiles. If you are making an RGB profile, separation settings do not appear.

**Note:** Change the separation settings only if the default settings do not provide satisfactory results. If you are profiling a Fiery Server, the default settings are the optimal settings for this type of Fiery Server.

1 In the Apply Settings window, click Edit Black Controls.

2 Set the following values in the Edit Black Controls window:

- **Maximum Total Ink** - Sets the total amount of ink allowed for the four channels: Cyan, Magenta, Yellow, and Black. The maximum value is 400%, which is 100% for each channel. Different types of output devices have standard maximum total ink values. The default setting is a value appropriate for the type of printer being profiled. We recommend you start with the default.

- **Maximum Black Ink** - Sets the total amount of ink that is allowed for black. You might reduce this value from 100% if that value produces undesirable effects, such as an unwanted difference between black and other colors. The default setting is a value appropriate for the type of printer being profiled. We recommend you start with the default.

- **Black Start** - Sets the minimum percentage of ink at which black is introduced into the mix of inks making up a specific shade of color. You might adjust this value to adjust the stability of the gray balance or to reduce graininess in highlights when the black screen is grainy.

- **Black Generation** - Also known as black transition. Sets the extent to which black ink is substituted for mixes of cyan, magenta, and yellow. Using one ink instead of three reduces moisture content in the underlying substrate when printing on a press and reduces cost, because black ink is less expensive than color inks. If black generation is set to a lower value, only neutrals and pastels have color removed to be replaced by black. If black generation is set to a higher value, more saturated colors are also affected.

  Set Black Start before setting Black Generation. Black Generation controls black output from the Black Start to the Maximum Black Ink value.

- **Increase black in shadows** - On some printers, adding cyan, magenta, and/or yellow to black ink can cause the black value to become lighter, rather than darker and richer. Adjusting this setting can make shadows appear more pleasing on those printers.
• Maximum CMYK density ratio - Affects rendering of the dark point of an ICC profile.
   If this option is not selected, the dark point is determined automatically. Automatic selection works well in most general applications.
   This option lets you specify the amount of black in the dark point. A ratio of 0% means that the dark point of the profile contains K only. A ratio of 30% means that the dark point contains 70% K plus additional percentage (to Maximum Total Ink) of CMY. 100% does not necessarily mean the same as Off. This option works well in situations where 100% K is darker than 400% CMYK.
   Maximum CMYK density ratio affects Maximum Black Ink. The range of Maximum CMYK density ratio is (100 - Maximum Black Ink) to 100.

• Black Width - Controls the distance from the neutral axis at which black generation is applied. A higher value uses more black off-axis; a lower value does not extend black generation as far out from the neutral axis.

• Black Amount to Extend Gamut - For most printers, the default value of 100% is sufficient. If there is a grainy appearance to the black halftone in saturated colors, reduce the percentage.

Save a profile in Printer Profiler

The Save Profile window lets you save a profile and include a description and other information. You can save the profile locally or install it on a Fiery Server or Fiery XF server.

**Note:** In Demo mode, you can save a profile in locked format and use it within Fiery Color Profiler Suite but not with other applications. To use the profile with other applications, you must activate the license for Fiery Color Profiler Suite.

1 In the Print Settings window, type the profile’s description.
2 Optionally, type any comments that you want to store with the profile.
3 Type the name of the media associated with the profile.
   For example, type the manufacturer and brand name of the paper used to print the patch pages.
4 Do one of the following:
   • To install the profile on a Fiery Server, click Install on Fiery Server and click the Fiery Server in the list.
     If the Fiery Server that you want does not appear in the list, click the plus sign (+) and select it from the network.
   • To install the profile on the Fiery XF server that you selected when you started, click Install on XF Server.
   • To save the profile locally, click Save on local drive.
5 Click Next.
6 If you save the profile locally, navigate to the profile’s new location, type a file name, click the ICC profile type (v2.0 or v4.0), and then click Save.
Create profiles based on the new profile

You can use the new profile to create a profile that has the same measurement data but with different settings, or create a device link profile that uses the new profile as its destination.

- Do one of the following:
  - To create a profile that has the same measurement data but different settings, click Change Settings, which returns you to the Apply Settings window.
  - To create a device link profile that uses the new profile as a destination, click Device Link.

Set Printer Profiler preferences

The Printer Profiler tab lets you set tolerance for calibration and measurement checks. These settings are specific to Printer Profiler.

Set calibration check tolerance

Printer Profiler can check whether profiling measurements match expected values (based on the current calibration). You set how much mismatch to allow without generating a warning.

1. In Color Profiler Suite, click Edit > Preferences.
2. In the Printer Profiler tab, select the Calibration check tolerance check box.
3. Enter the tolerance in the % density field.

Set measurement check tolerance

Printer Profiler can check whether profiling measurements of the same color in different locations match each other. You set how much mismatch to allow without generating a warning.

1. In Color Profiler Suite, click Edit > Preferences.
2. In the Printer Profiler tab, click the Measurement check tolerance check box.
3. Enter tolerance values in the Average dE and Maximum dE fields.
With Color Profiler Suite Calibrator, you can create a new calibration setting on a Fiery Server or update an existing one.

Like Calibrator in Command WorkStation, Color Profiler Suite Calibrator can create a new calibration setting and recalibrate an existing one, but with support for a variety of measurement instruments not available in Command WorkStation.

Calibrate a Fiery Server

To calibrate a Fiery Server, you select the Fiery Server, specify whether to create a new calibration or update an existing one, and then print and measure a calibration page.

1. In Color Profiler Suite, start Calibrator.

2. In the Welcome window, click Select Fiery Server and select the Fiery Server from the list.
   - If the Fiery Server is not in the list, click the plus sign to add it using the IP address or by searching.

3. Select a task and click Next.
   - Update calibration measurement - Recalibrate using the selected calibration setting.
   - New calibration measurement - Create a new calibration setting on the Fiery Server with the specified name.

4. Select any job settings needed to print the calibration page and click Print.

5. Click OK, retrieve the calibration page from the printer, and follow the on-screen instructions to measure it.

6. Click Apply.

If you created a new calibration setting, use Profile Manager in Command WorkStation to associate the calibration setting with an appropriate output profile.
Fiery Monitor Profiler

Fiery Monitor Profiler lets you create a profile of a CRT or LCD monitor, including laptop computer screens. Monitor Profiler uses the spectrophotometer included with Fiery Color Profiler Suite to measure a monitor’s color output.

You can use the easy or advanced profiling method.

**Note:** Monitor Profiler is not available in Demo mode.

Prepare to use Monitor Profiler

It is important to prepare your monitor before using Monitor Profiler.

1. Set the display settings of your computer to the optimal resolution and best color quality.
2. Turn off any screensaver or other software that might interfere with the display, especially any graphic arts software that might be color managing the display.
3. If your monitor has a control to reset the monitor to factory default settings, use it to reset the monitor.

Profile with the Easy method

The Easy method assumes the native monitor settings, and profiles the monitor in its current state.

You might use the Easy method if:

- You want to profile your monitor quickly.
- You want to profile your monitor in its current state or do not have a preferred state.
- Your monitor does not have controls for adjusting brightness, contrast, and RGB color.

1. Start Monitor Profiler and click Easy.
2. Calibrate and set up the spectrophotometer.
3. Measure profiling patches.
4. Compare before and after measurements.
5. Save the profile.
Profile with the Advanced method

The Advanced profiling method lets you specify desired monitor settings and calibrate the monitor to those settings, and then profiles the monitor in its calibrated state. Advanced users can also calibrate a monitor to a specified target. You might use the Advanced method if you want to:

- Profile your monitor calibrated to specific settings
- Use the monitor to emulate or match another monitor
- Be able to soft proof color on your monitor.

1. Start Monitor Profiler and click Advanced.
2. Select target settings for luminance, gamma, and white point.
   If you select the Native setting for luminance, gamma, or whitepoint, Monitor Profiler will skip the calibration of that parameter.
3. Calibrate and set up the spectrophotometer.
4. Measure and set luminance.
5. Measure and set gamma.
6. Measure and set the white point.
7. Measure profiling patches.
8. Compare before and after measurements.
9. Save the profile.

Calibrate and set up the spectrophotometer

Before measuring monitor output, you must calibrate and set up the spectrophotometer. Instrument calibration compensates for gradual drifts in the spectrophotometer. The spectrophotometer must be in its cradle, and the sample aperture must be in full contact with the white tile on the cradle. (If its position in the cradle is incorrect, the spectrophotometer returns inaccurate measurements.)

**Note:** The serial number on the spectrophotometer and the serial number on the cradle must match for accurate spectrophotometer calibration.

1. When instructed by Monitor Profiler, place the spectrophotometer in its cradle, and then click Next or press the button on the spectrophotometer.
2. If calibration fails, make sure the white tile on the cradle is uncovered and the white tile and instrument aperture are clean. Use a lens cloth and, if available, a lens cleaning solution.
3. Place the spectrophotometer on the monitor, using the holder that is included with the spectrophotometer.
   The spectrophotometer should lie flat in front of the outline displayed on the screen. The graphic in Monitor Profiler shows the correct position for the spectrophotometer.
Measure and set luminance

You can use Monitor Profiler to measure and set the brightness for the desired luminance. Luminance describes a monitor’s brightness in candels per square meter (cd/m²). Common luminance values range from 50 to 300. Some recommended luminance values are:

- CRT - 100
- LCD - 120
- Aged CRT - 80 to 90
- Laptop - 90

When you calibrate luminance, change only the brightness and no other monitor settings. The brightness control might be a physical button or an on-screen display (OSD) that appears on the monitor.

1. Correctly position the spectrophotometer for measuring.
2. If you use an OSD, position the OSD away from the spectrophotometer (in a corner of the screen, for example).
3. When Monitor Profiler tells you, adjust the brightness to the maximum value and click Next.
4. Reduce the monitor’s brightness until the measured luminance matches the target luminance.
   After each time that you adjust the brightness, wait a few seconds to allow the spectrophotometer to measure and display the resulting luminance.
5. Click Next.

Measure and set gamma

You can use Monitor Profiler to measure and set the contrast for the desired gamma. Gamma refers to the encoding of the luminance value to compensate for the nonlinearity in human vision, in order to achieve the best image quality for a given bandwidth. Gamma is the relationship of the encoded luminance to the desired output luminance. The gamma value affects the white point, the global ability to display RGB neutrals, and the global darkness and contrast that the monitor can display.

Typical gamma values range from 1.8 to 2.2 depending on the device.

When you calibrate the gamma, change only the contrast and no other monitor settings. The contrast control may be a physical button on the monitor or an on-screen display (OSD) that appears on the monitor.

1. Position the spectrophotometer correctly for measuring.
2. If you use an OSD, position the OSD away from the spectrophotometer (in a corner of the screen, for example).
3. When Monitor Profiler tells you, adjust the contrast to the maximum value and click Next.
4. Reduce the monitor’s contrast until the measured gamma matches the target gamma.
   After each time that you adjust the contrast, wait a few seconds to allow the spectrophotometer to measure and display the resulting gamma.
5. Click Next.
Measure and set the white point

You can use Monitor Profiler to measure and set the white point (RGB) settings that result in the desired white point.

The white point defines the exact white that the monitor displays.

- **Warm White (5000K)** - Also known as D50, is a yellowish white, recommended for image reproduction on CRT monitors. 5000 K is also the recommended viewing light for soft-proofing.
- **Medium White (6500K)** - Also known as D65, is a daylight white, recommended for image reproduction on CRT or LCD monitors if you prefer a white that is cooler than Warm White.
- **Cool White (7500K)** - Is a bluish white, for situations that specifically require a bluish white.

When you calibrate the white point, adjust only the white point and no other monitor settings. The white-point controls might be physical buttons on the monitor or an on-screen display (OSD) that appears on the monitor. After you calibrate the white point, you might need to adjust the brightness.

1. Correctly position the spectrophotometer for measuring.
2. If you use an OSD, position the OSD away from the spectrophotometer (in a corner of the screen, for example).
3. Locate the white point controls on your monitor.
   The control labels might be for white point, RGB, or color settings. There might be a single white point control or there might be three controls for Red, Green, and Blue.
4. Click Next.
5. If your monitor has a single white point control:
   a) Adjust the control until the measured white point value matches the target value as closely as possible. After each adjustment, wait a few seconds for the spectrophotometer to measure and display the results.
   b) Skip to step 9 on page 39.
6. If you the monitor has three controls for Red, Green, and Blue:
   a) Find the control with the middle value.
   b) Set the other two controls to that value as well.
   c) If these settings result in a noticeable color cast, reduce the dominant color (for example, reduce Red if the cast is reddish) to remove the cast.
   d) If the color cast persists, set Red, Green, and Blue to 20.
7. Do one of the following:
   - If the measured white point value is higher than the target value, either increase Red or reduce Green and Blue together (keeping the same value for Green and Blue), until the measured white point value matches the target value as closely as possible.
   - If the measured white point value is lower than the target value, either reduce Red or increase Green and Blue together (keeping the same value for Green and Blue), until the measured white point value matches the target value as closely as possible.
8 Adjust Green and Blue to match the target white point as closely as possible. 
You might not be able to match the target value exactly.

9 If the measured luminance no longer matches the target value, adjust the brightness control until it does. 
(Changing the white point can change the luminance.)

10 If the measured luminance is still too low at the maximum brightness setting, and your monitor has controls for 
Red, Green, and Blue, gradually increase all three controls, maintaining the same ratios, until the measured 
luminance matches the target value.

11 Click Next.

Measure profiling patches

Monitor Profiler displays a sequence of full-screen color patches that are measured by the spectrophotometer. 
You use the measurements to create a profile.

1 Position the spectrophotometer correctly for measuring.

2 Wait while Monitor Profiler displays a sequence of color patches. 
   This may take several minutes.

3 When Monitor Profiler reappears with a message that the measurements were completed, click Next.

Compare before and after measurements

Before you save the profile, you can check the measurements captured by Monitor Profiler by observing how a new 
monitor profile affects the display of a sample image. You can display the sample image using the new or existing 
monitor profile.

1 In the measurement results window, click Compare before and after to display the sample image.

2 Do one of the following:
   • Click After to display the sample image using the new monitor profile.
   • Click Before to display the sample image using the existing monitor profile.

Save a profile in Monitor Profiler

You can provide a description for the profile, and save it to your local system. The new profile automatically becomes 
the default monitor profile.

1 In the measurement results window, type a description that helps identify the profile.

2 Click Next.
3 Browse to the location for the new profile, type a file name, and click Save.

Monitor Profiler saves the profile in ICC v2.0 format.
Fiery Device Linker

Fiery Device Linker can help you use a device link profile to match color output to an industry standard. Device Linker also lets you simply create a device link profile using two to four profiles. In addition, you can optimize spot color definitions through iterative measurement of actual color output.

Device Linker offers these options:

- **Optimize a device link (Iterative match to a standard)** - Matches the output of your Fiery-driven printer to an industry standard (for example, SWOP). Device Linker creates a device link profile using a CMYK source profile that simulates the standard as the source profile and an output profile of the Fiery Server as the destination profile. Using measurements of the actual color output, Device Linker can optimize the resulting device link profile to target the color values that the standard specifies. With additional iterations of color measurements, you can fine-tune the optimization. Device Linker installs the profile on the Fiery Server.

- **Optimize spot colors** - Optimizes the spot color definitions on your Fiery Server. Device Linker loads the spot color definitions that reside on the Fiery Server. Using measurements of the actual color output, Device Linker can then optimize the spot color definition. With additional iterations of color measurements, you can fine-tune the optimization.

- **Create a custom device link** - Creates a device link profile from specified source and destination profiles. Optionally, you can include one or two intermediate profiles. You can save the resulting profile or install it on a Fiery Server.

**Optimize a device link (iterative match to a standard)**

To match your Fiery-driven printer to an industry standard, create a device link profile that simulates the standard as its source profile. Device Linker can optimize the device link profile to target the color values that the standard specifies.

Be sure that a CMYK source profile that simulates the target standard is installed on the Fiery Server. Use Printer Profiler to calibrate and profile the Fiery Server before you create the device link profile.

Device Linker creates a device link profile and lets you further optimize for your printer by measuring a patch page to determine the current state of your printer and incorporating the measurements into the device link conversion. You can repeat the printing and measuring of the patch page to progressively fine-tune the optimization with each iteration.

If iterative optimization does not result in printed colors that more closely match the standard, it might be for one of the following reasons:

- The printer is not performing up to its capabilities (not reaching the maximum toner or ink densities).
- The printer is not capable of printing to the target standard even performing at its best. The colors in the standard are out of the gamut of the printer.

1. In Color Profiler Suite, start Device Linker.
2 Click Optimize a device link (iterative match to a standard) and click Next.

3 Select the Fiery Server.

4 Click Create a new device link profile, select a source profile that is associated with the target standard (for example, ISO Coated), select the new output profile that you created in Printer Profiler, and click Next.

5 Click Next to accept the default settings.

6 Follow the on-screen instructions to print and measure a patch page using the spectrophotometer. When you print the page, do not change any color settings.

7 When the measurement results are displayed, click Iterate to further optimize the profile. With each iteration, you print a patch page using the optimization from the previous iteration and measure the page to determine how closely the colors match the standard.

8 Continue to print and measure patch pages until the measured delta E values are within your desired tolerances. If an iteration results in higher delta E values, delete the iteration and proceed with saving the profile.

9 Click Next to name the new profile, and then click Next to install the profile on the Fiery Server with the associated profile settings.

10 Click Done to close Device Linker.

If you decide that you would like to further optimize this device link profile, you can perform this procedure again, selecting the same profile to edit rather than creating a new one.

Optimize spot colors

Optimizing spot colors matches the printed spot color value to its expected value. When you optimize spot colors, you select a spot color library and the spot colors in that library that you want to optimize.

1 In the Welcome window of Device Linker, click Optimize spot colors, and then click Next.

2 Select the Fiery Server in the Select Fiery Server list.

3 Under Select output profile, click the File icon and select an output profile.

4 Select a spot color library in the Select spot color library list, and then click Next.

5 Click a spot color in the Available spot colors list, and then click Add.

6 Continue to add spot colors until all the spot colors you want appear in the Selected spot colors list, and then click Next.

7 Select the measurement instrument, patch layout (if available), and paper size, and then click Next.

8 Specify print settings and click Print. Do not change any color settings before printing.

9 Follow the on-screen instructions to measure the patch page using the spectrophotometer.

10 When the measurement results are displayed, click Iterate to further optimize the spot colors.
11 Continue to print and measure patch pages until the measured delta E values are within your desired tolerances.

12 If an iteration results in higher delta E values rather than lower, delete the iteration and proceed with saving and installing the edited spot colors.

13 Click Next to install the edited spot colors on the Fiery Server.

14 Click Done to close Device Linker.

Select profiles to create a device link profile

The profiles that you select depend on what you want to achieve. You can create a profile that matches printed output to a standard, or you can create a custom device link profile using specific source and destination profiles.

Select profiles for matching an industry standard

When you match a Fiery-driven printer’s output to a standard, you can create a new device link profile or edit a previously optimized device link profile. You will print and measure a patch page one or more times to optimize the device link profile.

1 Select the Fiery Server in the Select Fiery Server list.

2 Click one of the following:

   • To create a new profile, click Create new device link profile.

   • To re-optimize an existing device link profile that resides on the Fiery Server, click Edit previously optimized device link profile, and then select the profile from the list.

3 If you are creating a new device link profile, select the CMYK source profile that simulates the standard under Select source profile, and then select an output profile under Select destination profile.

To select a profile, click the File icon.

Select profiles for creating a custom device link profile

When you create a custom device link profile, you select the source and destination profiles. If you want to convert source colors to one or two intermediate color spaces before conversion to the target color space, you can also select one or two intermediate profiles.

1 Click Create a custom device link in the Welcome window, and then click Next.

2 Under Select source profile, click the File icon and select a source profile.

3 Under Select destination profile, click the File icon and select an output profile.

4 To add an intermediate profile, click Insert Intermediate Profile and select the intermediate profile.

5 To add a second intermediate profile click Insert Intermediate Profile and select the second intermediate profile.
Specify profile settings in Device Linker

When you create a device link profile using Device Linker, you set rendering intent and separation options that affect how Device Linker maps color values from source to destination. Device Linker uses these settings to create the device link profile.

Note: When you match to a standard, Device Linker automatically sets the options that affect color accuracy.

- **Black point compensation** - Scales the black point of the source color space to fit the range of lightness in the output profile, rather than clipping. This preserves black gradients, such as shadows. Black point compensation applies only to the Relative Colorimetric rendering intent.
  
  Click **Auto-detect** to apply black point compensation only when the source black point is lower (darker) than the destination black point. Click **Always** to always apply black point compensation.

- **Preserve gray** - Preserves RGB gray (R=G=B) or CMYK gray (CMY=0, K not zero) in the source and does not convert to black-only.

- **Preserve clean CMY primaries** - Prints pure cyan, magenta, or yellow input colors as pure cyan, magenta, or yellow. This option applies only if source and destination profiles are both CMYK and you are not creating a device link profile to match to a standard.

- **Black Separation** - Specifies whether to use the black generation of the source profile or the destination profile. It applies only if source and destination profiles are both CMYK and you are not creating a device link profile to match to a standard.
  
  Click **Same as destination profile (Output GCR)** to re-separate source colors using the black channel of the destination profile. Click **Preserve from document (Source GCR)** to preserve the black channel of the source profile.

1. Select the **Rendering Intent** to use between each linked profile. If you are matching to a standard, select **Relative Colorimetric** unless you want to print paper white simulation (for proofing).

2. Set the separation options as they apply to your device link profile.

Print patch pages for optimization

When you optimize a device link profile or spot colors using Device Linker, you print pages that contain patches of various colors and measure the patches with an instrument.

Alternatively, you can load existing measurements.

Note: Before printing a measurement page, you can set print options and other settings for sending the job to the printer. Do not change any color management settings.

1. Connect the measurement instrument to your computer.

2. Do one of the following:

   - To measure pages, click the measurement instrument in the **Instrument** menu.
   - To load measurement data from a file, click **Load measurements**, and then click **Next**.
3 Optionally, if you are measuring pages, click Settings and specify the instrument’s settings.

4 Select a Patch Layout setting if it is available.
   Fewer patches are faster to use, but more patches generally produce higher quality results.

5 Select a setting in the Paper Size list for printing the measurement page or click Custom and specify a custom page size.

6 Click Next to print the measurement page.

Check Device Linker measurement results and iterate

After you measure a measurement page to optimize a device link profile or a spot color, information about the measurements and the expected values appears. If you are not satisfied with the results, you can iterate (print and measure another page).

Calculated dE (Delta E) values compare measurement values with expected values. For a device link profile, the standard (CMYK source profile) are the expected values. For a spot color, the spot color library provides the expected values. Lower dE values indicate a closer match to the expected color.

For multiple iterations, dE values for all previous measurements appear so that you can see if the match is improving. You may want to delete an iteration if the results do not show any improvement.

1 Do one of the following:
   • If the dE values are acceptable, click Delete next to any iteration that you want to delete, and then click Next to continue and save the results.
   • If dE values are unacceptable, click Iterate to print and measure again to further optimize the match.

2 To view spot color measurements in Verifier, click View.

Save and install device link profiles

Device Linker lets you process, save, and install the device link profile(s) on a Fiery Server. If you are not creating a device link profile to match to a standard, you can save the device link profile locally.

When you create a device link profile on a Fiery Server, Device Linker automatically sets the profile association settings. (These settings determine how the job enables the device link profile).

If a job specifies the associated source profile as its CMYK Source Profile or RGB Source Profile and the associated destination profile as its Output Profile, the device link profile is enabled for the job.

If an associated source profile or destination profile does not already reside on the Fiery Server, it is installed along with the device link profile, so that it can be selected to enable the device link profile.

1 Type the profile’s description.

2 Optionally, type additional information under Comments.
3  Do one of the following:
   • If you are not creating a device link profile to match to a standard, click Install on Fiery Server and select the Fiery Server from the list.
   • If you want to save the profile locally, click Save on local drive.

   **Note:** If you are creating a device link profile to match to a standard, the profile is installed on the Fiery Server that you selected previously.

4  Click Next.

5  If you are saving the profile locally, navigate to the new profile’s location, type a file name, select the ICC profile type (v2.0 or v4.0), and then click Save.

   **Note:** The default location for profiles is the folder where the operating system installs profiles.

**View device link profile information**

After you create a device link profile, Device Linker displays information about the profile.

• If the profile was installed on a Fiery Server, the server name and the associated profile settings appear.
• If the profile was saved to the local computer, the file name and a link to the file location appear.
• If you optimized spot colors, information about the spot colors appears in Device Linker.
  You can also print a sample page.

• Click Print to print a sample page with the optimized spot colors.
Fiery Print Matcher

Fiery Print Matcher helps obtain consistent color output across a group of up to five Fiery-driven printers. Color results depend on different factors, but Print Matcher uses the Fiery Server color management features to help minimize these differences.

Note: Each Fiery Server must be running System 10 software or later.

Print Matcher provides different methods for matching printers, depending on the characteristics of the printers.

• Common calibration and output profile - For printers of the same model. The calibration curves of these printers are similar enough that Print Matcher can create a calibration goal and output profile that are common to all the printers.

• Common device link profiles - For printers of different models or manufacturers. Device link profiles map each printer’s output color space to the common color space between the printers.

Using measurement data from all selected printers, Print Matcher generates either a calibration and an output profile or a device link profile. When you use the calibration and output profile or the device link profile to print a job, you can print to any of the printers with similar color results.

Print Matcher can run in Demo mode and use almost all features. However, you cannot save a resulting calibration or profile to a Fiery Server.

Create a common calibration and output profile

For printers of the same model, Print Matcher uses color measurements from all of the printers to create a common calibration goal and output profile. For a new common calibration, you measure calibration pages and profiling pages for each Fiery Server in the list.

• A calibration goal specifies the target density values for a Fiery Server. The calibration goal specifies the maximum densities of C, M, Y, and K that all of the printers can print.

• The output profile represents the common color space between the printers. In other words, the output profile specifies only the colors that all of the printers can print.

You specify which printers to match by adding to the Fiery Server list during a session and giving the session a name. You use the session name if you update the calibration later. (If you update an existing calibration, you cannot change the list or the session name.)

You can specify just one printer if you want to create a new calibration using a measurement instrument that Print Matcher supports instead of matching printers.

Print Matcher installs the resulting calibration goal and output profile on each Fiery Server.

Note: You can exclude the measurements of one or more printers when calculating the calibration goal. Excluded printers are not profiled. If you exclude a printer from the common calibration, you can include it when you update the common calibration.
Create a new common calibration

Creating a new calibration starts with naming the session, choosing each Fiery Server, and printing a page that you can use to measure the printer's current color output (the maximum densities of C, M, Y, and K).

1. Click Printer Match in the Fiery Color Profiler Suite window.
2. Click New common calibration, and then click Next.
3. Type a name for this session.
4. Click the plus sign (+) to add each Fiery Server for each printer that you want to match, and then click Next.
5. In the Calibration print settings window, specify the settings for creating the calibration pages, and click Next.
6. Specify settings for printing the calibration job and click Print.
7. Retrieve the printed calibration page and follow the on-screen instructions to measure the page.
   Note: You can save the measurements, quit Print Matcher, and then resume this procedure later. Use Resume measuring session when you restart Print Matcher.
8. Print and measure a calibration page for each additional Fiery Server that you are matching.

Review calibration results

After you review calibration measurements, you can repeat measurements or exclude measurements from the calibration calculations.

Print Matcher does not install the common calibration goal and common output profile on an excluded Fiery Server. If you exclude a printer from the common calibration, you can include it when you update the common calibration at a later time.

1. Review the calibration results, and click Next.
2. If any results are questionable, click Reprint next to the results to reprint and remeasure a calibration page for the specific Fiery Server.
3. (Optional) If any results are out of the expected range after you repeat the measurement, exclude the Fiery Server by clearing the Include check box next to the results.

Create a common output profile

After creating the common calibration and reviewing the results, continue to create the common output profile.
If any results are questionable after you review the results, you can reprint the pages and measure again.
After you save the profile, Print Matcher installs it on each Fiery Server.

1. Specify settings for the profiling pages, and then click Next.
   Profiling pages are printed with the common calibration applied
2 After the profiling job is printed, click OK.

3 Retrieve the profiling pages from the printer and follow the on-screen instructions to measure the pages.

   **Note:** You can save the measurements, quit Print Matcher, and then resume this procedure later. Use Resume measuring session when you restart Print Matcher.

4 Print and measure profiling pages for each additional Fiery Server that you are matching.

5 Review the profiling results, and then click Next.

   Profiling pages include multiple patches of the same color. The maximum and average dE (Delta E) values summarize the variation in measurements of the same color.

   You can click Inspect measurements to look at the measurement data in Profile Inspector.

6 In the Apply Settings window, select the profile settings or import settings from an existing profile, and then click Next.

7 In the Save Profile window, specify the profile description, media, and any comments desired. Click Next.

   By default, the profile description is the name of the printer matching session.

8 To check your printer matching results, click Test Print to print a color test page to each Fiery Server.

---

**Update a common calibration**

A printer’s color output can change over time, so you must update a common calibration periodically to keep the color output consistent. If color consistency is important, we recommend calibrating your Fiery Server at least once a day.

1 Click Printer Match.

2 Click Update common calibration, click the printer matching session in the list, and then click Next.

3 If necessary, click Update to reconnect any disconnected Fiery Server in the list, and then click Next.

4 Specify the calibration page settings, and click Next.

   Use the same settings that you used when you created the common calibration.

5 Specify settings for submitting the calibration job to the specified Fiery Server and click Print.

6 Retrieve the calibration page from the printer and follow the on-screen instructions to measure the page.

7 Print and measure calibration pages for each additional Fiery Server that you are matching.

8 Review the calibration results, and then click Next.

9 Click Test Print to print a color test page to each Fiery Server, and check the printer matching results.
Create a new common device link profile

When printers are of different manufacturers or different models, Print Matcher can create a device link profile for each printer that you want to match.

Before you use this method, calibrate each Fiery Server and check that the measured data for each printer closely matches its target densities. If any profile does not produce acceptable color, create a new profile using Printer Profiler.

Print Matcher uses output profile data from each printer to calculate a gamut that is common to all printers. When one of the printers prints the job, it uses only those color capabilities that are common to all printers, regardless of the individual printer’s capabilities.

This method uses an existing output profile from the Fiery Server associated with each printer. The output profile from each Fiery Server is the intermediate profile in its device link profile. The destination in all of the device link profiles is the common color space between the printers. The resulting device link profile is installed on each Fiery Server.

1 In Fiery Color Profiler Suite, click Printer Match.

2 Click New device link, and then click Next.

3 Type a name for this session, click the plus sign (+) to add each Fiery Server for the printers that you want to match, and then click Next.

4 Select a source profile.

   A device link profile is created for each printer. Each device link profile uses this source profile. Select the CMYK source profile that you prefer for printing most jobs.

5 For each Fiery Server, select the output profile that you created, and then click Next.

   In each device link profile, the profile of the printer being matched is used as an intermediate profile, and the common color space is the destination.

6 In the Apply Settings window, select the profile settings and click Next.

7 In the Save Profile window, specify the profile description and any comments desired for each device link profile, and then click Next.

   The device link profile for each Fiery Server is installed on the corresponding Fiery Server and is associated with the source profile and output profile settings that match the profiles used to create the device link profile.

8 To check your printer matching results, click Test Print to print a color test page to each Fiery Server.

Print calibration pages

The Calibration print settings window lets you specify calibration pages.

Print Matcher lays out color patches on the calibration page according to the measurement instrument and paper size that you specify. You can also set the number of warmup pages to print. (Warmup pages are extra copies of the calibration page that you can discard.) We recommend that you measure the next-to-last copy printed.

1 In the Instrument menu, click the measurement instrument to use.
Print profiling pages

Print Matcher lays out color patches on measurement pages depending on the measurement instrument, patch layout, and paper size that you specify.

Patch layouts differ by the number of patches. Some are based on ICC standard targets.

You can also set the number of warmup pages to print. (Warmup pages are extra copies of the profiling pages that you can discard.) We recommend that you measure the next-to-last copy printed.

Using Expert Settings, you can change the ink or toner limits on your printer and specify the object type for the patches.

1 In the Instrument menu, click the instrument to use.

2 (Optional) To make specific settings for the instrument, click Settings.

3 Click a patch layout in the Patch layout menu.

- 46 - Provides the fastest profiling method using a handheld instrument. With this layout, additional data is mathematically calculated to ensure the quality of the resulting profile.
- 234 - Is fast to use and produces high-quality results with most printers that have a smooth color response.
- 928 (IT8.7/3) - Produces high-quality results on most printers. If you are unsure of your printer’s color response, use the 928-patch layout to ensure higher quality.
- 1485 (ECI 2002) or 1485 random (ECI 2002) - Comes from the European Color Initiative and incorporates two versions of IT8 targets. The random layout helps to reduce potential bias caused by color variation across the page.
- 1617 (CGATS IT8.7/4) or 1617 random (CGATS IT8.7/4) - Are similar to the 928-patch layouts but provide more data. The random layout helps to reduce potential bias caused by color variation across the page.
- 4028 - Provides the maximum color precision, the same level of precision as factory-supplied profiles from EFI.

4 Click Set number of warmup pages and then set a number.

5 (Optional) Click Expert settings and set the following:

- Ink or Toner Limits - Sets ink or toner coverage limits for printing patch pages. We recommend that you print with the default values unless your printer has problems printing with those levels.
- Create Patches As - Sets whether to create patches as bitmaps or vector graphics.

Bitmap images have color behavior similar to Adobe Photoshop images. Vector graphics have color behavior similar to Adobe Illustrator or Adobe Freehand illustrations. We recommend that you keep the default setting (bitmap images).
Specify output profile settings

You can set the gamut mapping, separation settings, profile optimization, and viewing condition for the output profile.

- For gamut mapping options, see Set gamut mapping on page 30.
- For separation options (black controls, see Specify separation settings on page 31.

Set profile optimization

The Optimize colorimetric precision option uses optimization to improve colorimetric precision and reduce dE (Delta E) values.

Increasing colorimetric precision can result in less smooth color transitions. Use this option for profiles that are used for printing proofs or for press certification but not for production workflows, where color perception is more important than precision.

- In the Apply Settings window, click Optimize colorimetric precision.

Set viewing condition

You can set the color of ambient light used when obtaining color measurements.

- In the Apply Settings window, do one of the following:
  - Click a setting in the Lighting value list.
  - Click the plus sign (+) to create your own setting, either by using a measurement instrument or by specifying the XYZ value.

Specify device link profile settings

In Print Matcher, you can specify and settings for rendering intent and separation options for the device link profile. These settings affect how color values are mapped from source to destination.

Separation options affect how the C, M, Y, and K components of the output are determined.

Black point compensation scales the lightness of all input colors to fit the range of lightness in the output profile, rather than clipping values outside of the range. This adjustment preserves black gradients, such as shadows.

1. Set the rendering intent to use for each link:
   - Source - Maps source colors to the intermediate profile (the output profile of the specific Fiery Server).
   - Output - Maps colors from the intermediate profile to the destination (common gamut).
2 Set Black point compensation:

- Auto-detect - Applies Black point compensation only if the input black point is lower (darker) than the output black point. For the Absolute Colorimetric rendering intent, this is the only setting available.

- Always - Applies Black point compensation always.
Fiery Profile Inspector

Fiery Profile Inspector provides an environment for inspecting RGB, CMYK, and named color profiles, displayed as two-dimensional or three-dimensional models in Lab color space. You can display multiple profiles (maximum of five) in contrasting colors for easy visual comparison.

Profile Inspector offers various display styles for profile models and tools for manipulating the models and the environment. You can also view specific color information about the profiles.

Profile Inspector can display data from a measurement file (IT8) plotted in Lab color space. You can also plot individual color measurements taken with a measurement instrument.

Display profiles

You can display a model of one or more profiles (maximum of five) in the modeling area, rendered in Lab color space. Controls let you adjust the background, lighting, opacity, and point size. In particular, you can display multiple models in contrasting colors.

1. Do one of the following:
   - Click File > Open, and click the profile.
   - Drag an ICC profiles from the desktop to the modeling area.

2. Adjust the controls to view the features of the profile model.

3. To show or hide a profile model, click the check box next to the profile name in the list.

Work with profile models in Profile Inspector

You can rotate, select points in, zoom, and display an interior cross-section of a model. You can also reset a model to its default position.

Reset a profile model to its default position

You can reset a profile model to its default position.

- Click the Home icon 🏠.
**Rotate a profile model**

You can rotate a model horizontally, vertically, or in all three dimensions.

1. Click the **Rotate** icon.
2. Do one of the following:
   - To rotate the model in three dimensions, click the model off center and drag.
   - To rotate the model around the horizontal axis, use the scroll wheel.
   - To rotate the model around the vertical axis, press the Ctrl key and use the scroll wheel.
   - To rotate around the L axis, press the Shift key as you drag the model.

*Note:* On Mac OS, Horizontal and Vertical scrolls on a mouse that supports these options rotate the model horizontally and vertically, respectively.

**Zoom a profile model**

You can zoom in and out of a profile model.

1. Click the **Zoom** icon.
2. Do one of the following:
   - To zoom in, click the model.
   - To zoom out, Alt+click (Windows) or Option+click (Mac OS).
   - To zoom a section of the model, drag to create a rectangular area.

*Note:* To zoom without clicking the Zoom tool, press Ctrl+= or Ctrl+_.

**View an interior slice of a model**

The Clip tool lets you pass an invisible vertical plane through the model from front to back, cutting away the portion it passed through. This creates a cutaway view of the model, which is useful when comparing two profiles.

1. Click the **Clip** icon.
2. The first time you use the Clip tool, click to reveal the clipping plane, and then drag up or down to make the clipping plane larger or smaller.
3. After the first time you use the tool, you can do either of the following:
   - To display the clipping plane, click near the bottom of the modeling area and drag up. (You may have to do this several times before the clipping plane appears.)
   - To move the clipping plane out of the model, click in the modeling area and drag down.
Select points in a profile model

You can choose points to display their color coordinates in the Measurements area. Profile Inspector inverts the selected point’s color to indicate that it is selected.

1. Click the Select icon.
2. Click the point that you want to select.

Set environment and display style for profile models

You can adjust the background, lighting intensity and display styles for profile models. For display styles, you can set how Profile Inspector plots the model, its color, rendering internet, opacity, and point size.

Note: Background, lighting, how to plot the model, and opacity are unavailable for 2D models.

• Set any of the following options:
  • Background - Sets the lightness of the background and the model’s saturation.
  • Lighting - Sets the intensity of the lighting. When Lighting is off, the model appears flat (no shading).
  • Plot As
    Surface - Displays the profile as a three-dimensional shape with a continuous surface.
    Slice - Displays the profile as a set of two-dimensional surfaces extending from the neutral axis through the primary and secondary hues.
    Edges - Displays the profile as the outlines of portions of the profile through the primary and secondary hues as well as the neutral axis.
    Points - Displays all input value points.
  • Color
    True Color displays actual colors in their correct locations. Other selections display the entire model in one color.
  • Rendering Intent - The ICC specification defines several ways of mapping colors from one color space to another, called rendering intent. A profile contains data for multiple rendering intents.
  • Opacity - Makes the profile model more or less transparent.
  • Point Size - Changes the points’ display size.
Display measurements from a file

You can display the measurements in an IT8 file (maximum of five files) in the modeling area, plotted in Lab color space. This allows you to compare the measurements with an existing profile.

1 Under Measurements, click the plus sign (+) and then click the file.
2 To show or hide the measurements, click the check box next to the file name.

Point information

When you select a point, Profile Inspector displays color information for the point in the lower right corner of the window.

The point information includes:

- **Description** - An internal description of the profile that contains the point.
- **Plotted** - The Lab value for the selected point. Profile Inspector plots the model in Lab space.
- **Input** - The device-dependent color value associated with the Lab value. The value may be CMYK, RGB, or a string value, depending on the color space of the selected profile.

Measure a color with an instrument

With a measurement instrument (such as the EFI spectrophotometer) that can measure a single color sample, you can measure a color and display the point in the modeling area.

Before you measure a color, you calibrate the instrument and then measure the color. When you measure a color, the Lab values appear in the lower right corner of the window and the measured point appears in the modeling area.

1 To calibrate the measurement instrument, click Instrument > (name of instrument) > Calibrate.
2 Place the instrument on the color you want to measure, and press the button on the instrument.
3 To measure another color, place the instrument on the new color, and press the button on the instrument.
4 To remove a measured point from the modeling area, select Instrument > Remove Point.
Fiery Profile Editor lets you modify an existing CMYK or RGB output profile.

- The reference image shows the effects of editing the profile. You can use the default image or select your own.
- The Color Information pane displays the source-to-output mapping of a selected color.
- The Rendering Intent menu shows which rendering intent is currently selected for editing.

Open a profile for editing

You can open a profile for editing at any time. The Editing Profile field displays the file name of the profile currently open for editing.

You can select a profile of the Output class in either the CMYK or RGB color space to edit.

1. Do one of the following to open a profile for editing:
   - Click File > Open Profile for Editing or File > Recent Profile.
   - Drag an ICC profile directly to the Profile Editor window.

2. If you are selecting a profile, select the location from which to search for profiles.

3. Click the profile and then click Select.

Select rendering intent

An output profile contains data for several rendering intents. When you edit a profile, the edit applies to a specific rendering intent. Be sure that you select the desired rendering intent before making an edit.

You can change the default rendering intent when you save a profile.

Profile Editor allows you to copy an edit from one rendering intent to another.

Depending on how a profile was created, it might share data between multiple rendering intents. In this case, an edit in one rendering intent necessarily affects the rendering intents that share common data. Profile Editor informs you if rendering intents share data when you change the Rendering Intent setting.

Absolute Colorimetric and Relative Colorimetric rendering intents always share data. An edit that you make in the Absolute Colorimetric intent is automatically duplicated in the Relative Colorimetric intent and vice versa.

The Absolute Colorimetric rendering intent is the only one that specifies the media whitepoint. Therefore, when you select the Media Whitepoint tool, the Absolute Colorimetric intent is automatically selected.
• Click a rendering intent in the Rendering Intent menu.

Save a profile in Profile Editor

When you save an edited profile, you can specify the profile’s default rendering intent and its profile descriptor. You can also flatten the profile and either install it on a Fiery Server or save it to your local computer.

**Note:** By default, Profile Editor saves an edited profile with a new file name, preserving the original file.

The profile descriptor is the profile’s name that appears in an application. For example, a program that lets users select from a list of profiles displays the profile descriptors of the available profiles.

Flattening the profile simply removes extra data that only the Profile Editor uses. You can flatten a profile if you do not intend to edit it again. If you do not flatten a profile when you save it, Profile Editor stores the profile’s edit list inside a private tag. An unflattened profile is fully ICC-compatible and you can used it the same as a flattened profile.

**Note:** You cannot undo flattening. We recommend that you keep a copy of the unflattened profile.

1 Do one of the following:
   • Type a new profile descriptor directly in the Name your profile field.
   • Click Options, then type a new profile descriptor, or click an Edit Version icon (v↓ v↑) to change the edit version suffix.
   • To add a new profile descriptor, click the Add icon (+) and double-click any field to type a new value.

2 Click a rendering intent in the Rendering intent list.

3 (Optional) Type additional information under Comments.

4 (Optional) Click Flatten Profile.

5 Do one of the following:
   • To install the profile on a Fiery Server, click Install on Fiery Server and click the Fiery Server in the list.
   • To save the profile locally, click Save on local drive.

6 Click Save.

7 Do one of the following:
   • If you install the profile on a Fiery Server, specify the profile settings and click OK.
   • If you save the profile locally, navigate to the location in which you want the profile saved, and click Save.
Output profile settings

You can specify the settings of an output profile when you import it to a Fiery server. In the Profile Settings dialog box, select the settings as needed.

Media Type lets you specify the profile’s media settings. When a job is configured to use the output profile defined by its media settings (the media-defined profile) and the job has one of the selected media settings, this profile is used to print the job.

You can associate a calibration with more than one output profile. However, the calibration data for any existing calibration might not be appropriate for your profile. In this case, use Calibrator in Command WorkStation to create a new calibration, associate it with your profile, and calibrate to get new measurement data.

Reference image

The reference image shows how the edited profile affects color output. Profile Editor can display three different views of a reference image (source, original output, and edited output).

The two sample reference images consist of multiple images containing a variety of image types and color values. Color swatches in the reference images include primary colors, neutral tones, and some common “memory” colors, such as sky blue and grass green. The images are in the Samples/Images folder in the Fiery Color Profiler Suite installation directory.

Note: The color swatches are static and do not change to show the effects of the edited profile.

You can use any CMYK or RGB image in JPEG or TIFF (8-bit or 16-bit) file format as a reference image. Profile Editor uses the source profile you specify to interpret the image’s colors.

Reference image tools

Profile Editor provides tools for changing or using the reference image.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Keyboard shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Eyedropper</td>
<td>I or Ctrl I</td>
<td>Click a color in the image or color bar to display in the Color Information pane. The Eyedropper tool also changes the source color for the Selective Color, Hue Edit, and Node Edit tools.</td>
</tr>
<tr>
<td></td>
<td>Roam</td>
<td>M or Ctrl M</td>
<td>Drag to slide the image quickly in a particular direction. Use the Roam tool to move from one edge of the image to another when the image is too large to fit inside the pane.</td>
</tr>
<tr>
<td></td>
<td>Move</td>
<td>H or Ctrl H</td>
<td>Drag to move the image around. Use the Move tool to bring a part of the image into view when the image is too large to fit inside the pane.</td>
</tr>
</tbody>
</table>
### Open a reference image file

You can select the reference image. You can display the reference image using its embedded profile if it has one.

You can also select a different profile for an image that has an embedded profile. This is useful if you intend to represent the image using a different source profile. If you do not know which source profile to use, you can select different profiles and compare the results.

1. Click File > Open Reference Image, click the file, and then click Open.

2. To display the image using its embedded profile, click Keep embedded profile.

   **Note:** This option is available only if the image has an embedded profile.

3. If there is no embedded profile, click Select source profile and locate the file,

4. Click the profile, and then click Select.

### Select source profile to display reference image

You can change the source profile used to display the reference image.

You can select a source profile of the Input, Display, or Output class to render the reference image. The color space of the source profile must match the color space of the reference image.

1. Click File > Select Source Profile.

2. To display the image using its embedded profile, click Keep embedded profile and then click OK.

   **Note:** This option is available only if the image has an embedded profile.
3 To use a different profile or if there is no embedded profile, click Select source profile and click Browse. Click the profile, and then click Select.

**Preview output media color**

The Preview Output Media Color option displays the reference image using the color of the output medium (or substrate) simulated. The display shows paper white according to the profile's media whitepoint of the profile.

You can select this option in any rendering intent. Selecting Absolute Colorimetric rendering intent automatically selects Preview Output Media Color because you can edit the media whitepoint only in the Absolute Colorimetric rendering intent.

**Note:** The Preview Output Media Color option does not provide an accurate soft proof, only an approximation of the printed colors and the media color.

- Click Preview Output Media Color.

**View source, original output, and edited output views**

Profile Editor lets you view the reference image as the source, output, or edited output.

- Click one of the following:
  - Source (▼) - Displays the image using the selected source profile.
  - Output (Original) (□) - Displays the image as it would appear printed using the output profile without any edits.
  - Output (Edited) (■) - Displays the image as it would appear using the output profile with edits.

**Display color information for a source color**

The Color Information pane displays a color swatch and numerical color values for one source color and its corresponding colors in the original and edited profiles.

The calculated numerical differences between the colors appear above the swatches.

The selected color is also the source color for the Selective Color, Hue Edit, and Node Edit tools.

- To select a source color, do one of the following:
  - Use the Eyedropper tool (▼) to sample a color in the reference image.
  - Type values in the source fields.
  - Click the measurement instrument icon (▼) and sample the color of a physical object using the spectrophotometer.
Set the color model for representing color values

You can set a different color model to represent the numerical color values in the Color Information pane. When you change color models, Profile Editor calculates and displays the equivalent values for the same color.

These icons indicate the current color model:

- Sets CMYK.
- Sets RGB
- Sets Lab
- Sets XYZ

1. Click the icon for the color model.
2. Click the color model that you want in the list.

Set method for calculating Delta E

You can set the method for computing the Delta E between the source, original output, and edited output colors. Choose the method most familiar to you.

The numerical difference between any two colors is called Delta E (\(\Delta E\) or \(dE\)).

Individual colors are not distributed linearly across a color space. When the \(dE\) of two colors is computed by simple subtraction, the same numerical value can represent a very different visual difference, depending on the region of the color space where the two colors are located. There are a number of established methods for calculating \(dE\) that apply different approaches to make the numerical differences correspond to the visual differences.

The most commonly used method for calculating \(dE\) is \(dE^{*ab}\), which is the default method. This method is the simplest to calculate. The other methods (\(dE\) 94, \(dE\) 2000, and \(dE\) CMC) are more complicated to calculate but are better at reflecting the visual differences between colors. The \(dE\) 2000 method is the most modern method.

1. Click the \(dE\) icon (\(\Delta E\)).
2. Click the method in the list.

Edit colors and the Edit List

The Edit Tools pane lets you edit colors and view or change the list of edits already created. The Edit List displays, for the selected rendering intent, the edits that have been made.

The Edit List displays edits in the following order, which is the order in which they are applied:

- Media Whitepoint edit (Absolute Colorimetric rendering intent only)
- Global Color edit (one per rendering intent)
- Hue edits, in the order created
- Selective Color edits, in the order created
- Node edits, in the order created
**Note:** Because each edit applies to a specific rendering intent, the Edit List changes when you change rendering intents.

Flattening a profile when you save it clears the Edit List. If you do not flatten a profile when you save it, the edit list is stored in the profile. An unflattened profile is fully ICC compatible.

You can choose one or more edits in the list to perform tasks on them.

1. To see the Edit List of edits already made for the selected rendering intent, click the up or down arrow at the bottom of the Edit Tools pane.

2. Use these tools to edit colors:
   - **Edit color globally** - Adjusts the lightness, contrast, and saturation of the entire output and adjusts each individual output curve (CMYK or RGB).
   - **Edit the colors in a hue** - Shifts all colors of the same hue and a user-specified range of neighboring colors to a different hue.
   - **Edit a selected color** - Changes one color and a user-specified range of neighboring colors in the source to a different color in the output.
   - **Edit a node** - Changes the color content of an individual node in the profile color table.
   - **Adjust white point (media color)** - Changes the whitepoint value. Applies only to the Absolute Colorimetric rendering intent.

**Edit color globally**

Each rendering intent in a profile can have only one global color edit, but the global color edit can modify multiple properties.

1. Click Global Color.

2. Click one of the following tabs, depending on the type of edit that you want to make.
   - **Lightness, Contrast, Saturation** - Drag the sliders to adjust the lightness, contrast, and saturation of all colors.
   - **Output Curves** - Drag the curves to adjust the input vs. output for each color channel.

**Edit output curves**

You can edit curves showing input vs. output for each color. You can edit only one curve at a time.

The eye icon under each color square in the channel selector indicates whether the color curve is being displayed. (One curve might be behind another.)

1. Click a curve’s color square to bring a curve to the front.

2. Click anywhere on the curve to create an edit point, and then drag the edit point to change the shape of a curve. Other edit points on the same curve remain fixed.
Edit the colors in a hue

A hue edit is similar to a selective color edit, but it affects all colors of one hue rather than only a single color. Use a hue edit to shift one hue in the source to a different hue in the output.

The hue edit applies to the source color currently set in the Color Information window.

Hues near the selected hue in the color space are affected by the hue edit. To preserve the smoothness of a color gradient, you can increase this range of nearby hues. At the maximum range, a hue edit affects nearly all colors.

1 Click Hue Edit.

2 Click one of the following Hue Selection tools and use it to specify the output hue:

- **Hue and Saturation** - Drag the Edited marker to set the hue and saturation values of the output hue.
- **Profile Cross Section** - Locate the output hue in a graphical representation of the output color space. The color model (Lab or XYZ) that displays the color space is the same as the Profile Connection Space of the profile being edited. The cross-section is a vertical plane of the Lab or XYZ color space where all the colors have the same ratio of a/b or X/Y as the source color.

Set hue and saturation of the output

Hue and Saturation allows you to set the hue and saturation of the output hue.

A plus sign (++) to the left of each color bar indicates the source values. A white square (□) to the right of each color bar indicates the output values of the original profile. A filled square (■) to the right of each color bar indicates the output values of the edited profile.

The narrow areas of the Relative Saturation bar indicate that relatively fewer values are in-gamut. Where the bar is thinnest, there are no in-gamut values.

**Note:** If the Saturation setting you want has no in-gamut values, try adjusting the Hue again.

1 Click Hue Edit.

2 Click Hue and Saturation and set Hue, Saturation, and Range for the output hue.

Select output hue using Profile Cross Section

Profile Cross Section locates the output hue in a graphical representation of the output color space.

The color model (Lab or XYZ) used to display the color space is the same as the Profile Connection Space of the profile being edited. The cross-section is the horizontal plane (all colors have the same level of lightness) that contains the source color in the Lab or XYZ color space.

The Edited color indicator (filled square) moves to the location that you set. A line drawn from the neutral (center) axis to the Edited color indicator represents the new output hue. Profile Editor updates the colors close to the edited hue (depending on the Range value).

1 Click Hue Edit.

2 Click Profile Cross Section.
3  Click the Eyedropper tool (alaria).

4  Click the new location for the output hue in the color space.

**Edit a selected color**

Selective color edit lets you change one color in the source color space to a different color in the output. This is useful if you need to reproduce an individual color exactly (a company logo color, for example).

The selective color edit affects colors near the selected color in the color space. To preserve color gradient smoothness, you can increase this range of nearby colors. At the maximum range, a selective color edit becomes similar to a hue edit.

The selective color edit applies to the source color currently selected in the Color Information window.

1  Click **Selective Color**.

2  Click one of the following Color Selection tools and use it to specify the output color:

   - **HLC Entry** - Drag the Edited marker to set the hue, lightness, and chroma (similar to saturation) values of the output color.
   - **Coordinate Entry** - Type the color space coordinates of the output color or use the spectrophotometer to sample the color of a physical object.
   - **Profile Cross Section** - Locate the output color in a graphical representation of the output color space. The color model (Lab or XYZ) that displays the color space is the same as the Profile Connection Space of the profile being edited. The cross-section is a vertical plane of the Lab or XYZ color space where all the colors have the same ratio of a/b or X/Y as the source color.

**Set hue, lightness, and chroma of the output color**

HLC Entry lets you set the hue, lightness, and chroma (similar to saturation) values of the output color.

A plus sign (++) to the left of each color bar indicates the source values. A white square (□) to the right of each color bar indicates the output values of the original profile. A filled square (■) to the right of each color bar indicates the output values of the edited profile.

The narrow areas of the Lightness and Chroma bars indicate that there are relatively fewer values that are in-gamut. Where the bar is thinnest, there are no in-gamut values.

1  Set the Hue value of the replacement color by dragging the filled square (■) on the Hue bar to move it up or down.

2  Set the Lightness value of the replacement color.

3  Set the Chroma value of the replacement color.

4  If there are no in-gamut values at the Lightness and Chroma setting you want, try adjusting the Lightness and Chroma again.
Set color space coordinates

Coordinate Entry lets you type the color space coordinates of the output color or use the spectrophotometer to sample the color of a physical object.

**Note:** To set a different color model, click the color model icon (for CMYK, for example) to the left of the numerical fields, and set the color model from the list.

1. (Optional) Do one of the following to set the source color:
   - Under **Change Source Color**, type the coordinates for the source color.
   - Click the measurement instrument icon and sample the color of a physical object using the spectrophotometer.

2. Do one of the following to set the output color:
   - Under **Target Output Color**, type new coordinates for the output color.
   - Click the measurement instrument icon and sample the color of a physical object using the spectrophotometer.

Select output color using Profile Cross Section

Profile Cross Section locates the output color in a graphical representation of the output color space.

The color model (Lab or XYZ) that displays the color space is the same as the Profile Connection Space of the profile being edited. The cross-section is a vertical plane of the Lab or XYZ color space where all the colors have the same ratio of a/b or X/Y as the source color.

1. Click the **Eyedropper** tool.
2. Click the new location for the output color in the color space.

   The Edited color marker (filled square) moves to the location that you set. Profile Editor updates the colors close to the edited color (depending on the Range value).

Edit a node

An output profile uses a set of data points called nodes. A node represents a sampled color at various locations across the color space of a profile.

For colors that do not correspond exactly to a node color, Profile Editor infers colors by assuming that the transitions from one node color to another are smooth and continuous. Thus a relatively small number of nodes can represent the entire color space (a very large number of colors).

Profile Editor represents the Node Index as Axis 1, Axis 2, and Axis 3. These axes correspond to either L, a, and b or X, Y, and Z depending on the model used by the Profile Connection Space (PCS) of the profile being edited.

Typing a value in the Neutral field locates that node on the neutral axis and adjusts the values of Axis 1, Axis 2, and Axis 3 to match. You can increase or decrease the Neutral value to view the nodes associated with different gray levels.
For any given node index, the coordinates of the source and output colors associated with the node index are displayed.

A node edit has the smallest effect of any type of edit and changes only one node in the profile. (The node edit alters only the relationship of the color at one node to the colors around it and affects color transitions in the node’s neighborhood.) By comparison, a selective color edit affects at least eight nodes.

One example of using a node edit is to adjust the neutral colors \((a=b=0)\) of a profile. These adjustments are usually very small.

**Note:** If you are editing a node that is near the edge of the gamut, we recommend that you specify the replacement node color in CMYK color space rather than Lab. In this situation, the CMYK color space allows you more precise control in specifying a color than the Lab color space.

### Highlight affected colors

If you want better visibility of the selected node, you can apply a contrasting color.

- Select the Highlight check box to display the colors in the reference image and in the color space affected by this edit in a contrasting color. Use this option to see which colors are affected by this edit.

### Set node and color coordinates

Node and Color Coordinates allows you to type the node’s index and color space coordinates of its output color or use the spectrophotometer to sample the color of a physical object.

1. Set a node using one of two methods:

   - Set a source color, or click the source measurement instrument icon \(\text{Nearby (Source)}\) under Nearby (Source) Color and sample the source color using the spectrophotometer, and then click Find Nearest Node.
     
     If the currently selected color does not correspond exactly to a node, the color of the node nearest to the selected color is selected.

     - Under Node Index, type the coordinates of the node index.

2. Do one of the following:

   - Under Replacement Node Color, type the output color’s coordinates.

   - Click the output measurement instrument icon \(\text{Nearby (Output)}\) and sample the output color using the spectrophotometer.

### Select output node using Profile Cross Section

You can set a source color and locate the corresponding output color in a graphical representation of the output color space.

Profile Cross Section can display the output color that corresponds to a source color. The display, using a graphical representation of the output color space, uses the same color model (Lab or XYZ) as the Profile Connection Space of the profile.
XYZ color space is a horizontal plane where all colors have the same level of lightness.

- **Leaf** displays a two-dimensional plane of the Lab or XYZ color space. This is a vertical leaf where the ratio of a/b or X/Y of all colors is the same.
- **Plane** displays a two-dimensional plane of the Lab color space.

The color model (Lab or XYZ) used to display the color space is the same as the Profile Connection Space of the profile being edited.

1. Click **Plane** or **Leaf**.

2. Set a node using one of these methods:
   - Set a source color, or click the source measurement instrument icon (_nearby source color_ icon) under Nearby (Source) Color and sample the source color using the spectrophotometer, and then click Find Nearest Node. If the currently selected color does not correspond exactly to a node, the color of the node nearest to the selected color is selected.
   - Click the source Eyedropper tool (source eyedropper icon), and click the node you want to edit in the profile cross-section.
   - Type the coordinates of the node index directly. You can also use the up arrow or down arrow to increase or decrease a value.

3. Under **Replacement Node Color**, set the output color using one of two methods:
   - Type the coordinates of the output color, or click the output measurement instrument icon and sample the output color using the spectrophotometer.
   - Click the output Eyedropper tool (output eyedropper icon), and click the output color in the profile cross-section.

---

### Adjust white point (media color)

The Media Whitepoint Edit tool can adjust the profile for the color of the paper stock. Setting the Media Whitepoint tool automatically selects the Absolute Colorimetric rendering intent, which is the only rendering intent that specifies media color.

You can set the Lab or XYZ color model to edit the whitepoint.

The color swatches show the colors of the original and edited media whitepoints.

- Do one of the following:
  - Type values in the Edited fields.
  - Click the measurement instrument icon (measurement instrument icon) and use the spectrophotometer to sample the color of the media (paper).
Sample a color with a measuring instrument

With a spectrophotometer connected to your computer, you can sample a color in any place where you see the measuring instrument icon with a “green light” (вшего) to indicate that the icon is active.

**Note:** Before using the spectrophotometer, you must initialize and calibrate it.

1. Click the icon to activate the green light if it is not already displayed.

2. Click **Instrument > EFI ES-2000 > Calibrate** and follow the on-screen instructions for calibrating the instrument.
EFI Verifier in Fiery Color Profiler Suite helps you check printed color against a standard reference. You print and measure a color bar and compare the measured results to a reference using a selected set of tolerances. If a measured value matches its expected value within the tolerance, the printed color meets the standard for the specific color. If all colors pass, the printed output fully conforms to the reference.

Verifier provides a number of reference presets, which are predefined combinations of a reference (such as Fogra 39L) and a color bar (set of color patches to be measured). You can define new reference presets as well.

Before using Verifier for the first time, set the preferences to specify the reference preset, tolerance set, the Fiery Server and the paper size for printing, and the measurement instrument.

For more information about the main screen in Verifier, select Help > Help.

**Note:** Verifier is not available in Demo mode.

### Verify color against a reference

To verify color, you print and measure a measurement page for a specific reference. If the page is already printed, you can skip printing.

1. In Fiery Color Profiler Suite, click Verify.
2. Select a reference preset.
   - If the reference preset that you want is not in the list, click Preferences to add it.
3. Click Print to print the measurement page, or if you already have a printed measurement page, click Measure and skip the next two steps.
4. Select a paper size for printing the measurement page or click Custom and specify a custom page size, and then click Print.
   - The Fiery Server and measurement instrument for printing are set in Preferences.
   - If you want to skip this step in the future, select Remember settings and do not show dialog again.
5. Optionally, before printing the measurement page, you can set print options and other settings for sending the page to the printer. Do not change any color management settings.
6. Follow the on-screen instructions to measure the page.
7. When you are done measuring, click Next to view the results.
   - Verifier displays the reference values compared with the measured values and indicates pass or fail for each value.
   - To record the results, you can print a report or a label. For more information, select Help > Help.
Set Verifier preferences

Verifier preferences let you specify default settings for Verifier options.

You can set:

- **Reference preset** - A predefined combination of reference and color bar (set of color patches).
- **Tolerance** - A set of tolerance values for pass/fail tests.
- **Print settings** - The Fiery Server for printing, the paper size, and the measurement instrument.

**Set a reference preset**

A reference preset is a combination of reference and color bar (set of color patches). It specifies what color patches to print and what reference (expected values) to compare the measured values to. You can add a reference preset for each of the combinations that you use frequently.

**Note:** For more information about references (characterization data) and color bars (charts), select Help > Help in the main screen of Verifier. You can also load a custom chart from a file.

1. In Color Profiler Suite, click Edit > Preferences.
2. In the Verifier tab, select a preset in the Reference chart preset list.
   
   To create a new preset, click the plus sign. To remove the selected preset, click the minus sign.

**Set a tolerance set**

The tolerance set is used by Verifier to compare measured values to expected values to determine passing or failing results. The tolerance set that you specify for Verifier is automatically applied when the results are displayed. You can select a different tolerance set in the Verifier main screen in the Comparison Settings option.

**Note:** For more information about Comparison Settings, select Help > Help in the Verifier main screen.

If you are not sure which tolerance set to use, select ISO 12647-8 Validation Print "Media Wedge". It includes targets for dE, dH, and dCh.

1. In Color Profiler Suite, click Edit > Preferences.
2. In the Verifier tab, select a tolerance set in the Tolerance list.
   
   To specify customized tolerance values that are already set in Verifier, select Custom.

**Set print settings**

1. In Color Profiler Suite, click Edit > Preferences.
2 In the Verifier tab, select the following settings.
   - Server - Select a Fiery Server for printing the page. To add a Fiery Server to the list, click the plus sign.
   - Paper size - Select a paper size for printing the measurement page or click Custom and specify a custom page size.
   - Instrument - Select the measurement instrument. Optionally, click Settings to set options for the instrument.

3 The Print settings dialog box lets you select the paper size and job settings before printing the measurement page. If you always want to print using the default settings, clear the Display print settings dialog option.
Fiery Auto Verifier

Fiery Auto Verifier helps you monitor color accuracy for specific print settings on a Fiery Server.

To use Auto Verifier, you must select at least one Fiery Server and configure the settings for printing the test page. Test pages containing CMYK color patches are sent from your computer to the Fiery Server at the specified interval (elapsed time or number of impressions printed).

After a test page is printed, you can run Auto Verifier to measure the test page and record the data. You may choose to wait and print several pages and measure them all at the same time.

Auto Verifier lets you measure the test pages and compare the results with tolerance values for CMYK Color Matching in Fiery Color Verification Assistant. The test gives a pass or fail result. You can record test results in a report or use them to generate a label. You can view the test results in Verifier. For tracking color quality over time, you can also configure Fiery Dashboard to retrieve and display test results.

**Note:** For more information about Fiery Dashboard, see the Products section of the EFI website.

**Note:** Auto Verifier is not available in Demo mode.

Configure automatic test pages

To print test pages automatically, you must configure Fiery Color Profiler Suite preferences to specify the Auto Verifier settings.

1. In Fiery Color Profiler Suite, click Auto Verify to start Auto Verifier, and then click Preferences.
2. In the Auto Verifier tab, click the plus sign (+) and add a Fiery Server to the list.
3. Select the server preset or virtual printer for printing the test page, set the interval (in time or number of impressions) at which to print the test page, and click OK.
4. Select the measurement instrument and the patch layout for the test page.
5. Click the CMYK Color Matching tab to view or edit the test tolerances.

As long as your computer is running and can connect to the Fiery Server, test pages will print even if you close Fiery Color Profiler Suite. You can monitor the test page jobs in Command WorkStation.

Turn off automatic test pages

If the Fiery Server is unavailable, you may want to turn off Auto Verifier test pages temporarily.

1. In Fiery Color Profiler Suite, click Auto Verify to start Auto Verifier, and then click Preferences.
2 In the Auto Verifier tab (under Color Verification Assistant), clear the check box next to the name of the Fiery Server in the list.

Measure test pages

Auto Verifier’s CMYK Color Matching test checks how accurately the printed output matches the CMYK source profile.

The test computes the differences between the measured and expected color values for the selected CMYK source profile and output profile. A difference greater than the tolerance for the test generates a failure. You set tolerance values in the Preferences for Fiery Color Verification Assistant.

Note: A check mark by the job ID indicates that the page has been measured previously.

1 In Fiery Color Profiler Suite, click Auto Verify to start Auto Verifier.
2 Click the job ID in the list that matches the job ID on the color test page, and click Next.
3 Follow the on-screen instructions to measure the page.
4 In the Measurement Results window, click Results to see the test results.

Record test results

After you measure a test page in Auto Verifier, you can print the test results in label or report format, and you can view the test results in Verifier.

- The label contains a summary of the test results in label format. You can post the label as a status indicator.
- The report contains the complete test results. You can file the report to keep a log of printer performance.

You can also view the results in Verifier if you want to use Verifier features with the test data. For example, Verifier can save the test data.

1 Do one of the following in the test results window:
   - To print a label, click Print Label.
   - To create a report, click Create Report.
2 Specify the information that you want to appear in the label or report header.
3 If you want to save the information that you entered, click Save Properties and save the file.
4 If you want to include information from a previously generated report, click Load Properties and open the file. Data from the file overwrites all fields.
5 If you are printing a label, click OK and check the preview.
6 Click OK, specify the printer, and click Print.
If you want to view the results in Verifier, click the link to Verifier.
Fiery Color Verification Assistant

Fiery Color Verification Assistant helps evaluate the color accuracy resulting from printing to the Fiery Server with specific print job settings. The application guides you through a set of test measurements and then compares the measurements with tolerance values to produce pass/fail test results.

**Note:** Color Verification Assistant does not run in unlicensed (Demo) mode.

Color Verification Assistant is useful when you want to verify color on a Fiery Server and do not need the full features of Verifier.

You can adjust the tolerance values for tighter or looser test limits.

### Run verification tests

You can start Color Verification Assistant from Command WorkStation when Color Profiler Suite is installed on the same system as Command WorkStation. You do not access Color Verification Assistant from the main window of Color Profiler Suite. Color Verification Assistant does not require Administrator or Operator privileges in Command WorkStation.

1. In Command WorkStation, connect to the Fiery Server that you want to evaluate.
2. Select a printed or held job that has the print settings that you want to evaluate, and click Actions > Color Verification.

   Make sure to select only one job. Color Verification Assistant cannot be started if multiple jobs are selected.

   **Note:** The Command WorkStation window is not updated while Color Verification Assistant is running. You must exit Color Verification Assistant to continue using Command WorkStation.

3. If necessary, click Next to process the job.
4. Select the tests to run:
   - **CMYK** - Verifies how accurately the printed output matches the output that would be expected for the CMYK source profile.
   - **RGB** - Verifies how accurately the printed output matches the output that would be expected for the RGB source profile.
   - **Output Profile** - Verifies how accurately the printed output matches the specified output profile.
   - **Printer** - Verifies whether the printed output is consistent (repeatable).
   - **Measurement Device** - Verifies whether the spectrophotometer measurements are consistent (repeatable).
5. Set the measurement device and any associated settings.
To print the measurement pages, click Next.

Follow the on-screen instructions to measure the patch pages, and then view the results.

Click Results next to the test name to see the detailed test results.

In the detailed test results, you can perform other optional tasks.

- Click the link to Verifier to view the test data in Verifier.
- Print a label that contains a summary of the test results.
- Print a report that contains the detailed test results.

View test results

The Measurement Results window displays the pass/fail test results. Each test consists of multiple measurements. Detailed test results show the value and result for each measurement included in the test. If the difference between the measured value and the expected value is greater than the specified tolerance for a specific test, the test fails.

You can open Verifier to view all the data used by Color Verification Assistant to generate the test results. The set of tolerance values (from the Preferences window) used for the test is also transferred to Verifier as the Fiery Color Verification Assistant preset. The two sets of colors that are compared in Verifier are called M1 and M2. The table below shows the contents of M1 and M2 for each test in Color Verification Assistant.

<table>
<thead>
<tr>
<th>Test name</th>
<th>M1</th>
<th>M2</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMYK Verification</td>
<td>Data computed from CMYK source profile and output profile</td>
<td>Measurements of CMYK patches on Simulated Color Spaces page</td>
</tr>
<tr>
<td>RGB Verification</td>
<td>Data computed from RGB source profile and output profile</td>
<td>Measurements of RGB patches on Simulated Color Spaces page</td>
</tr>
<tr>
<td>Output Profile</td>
<td>Data extracted from output profile</td>
<td>Measurements of patches on Fiery Printer Color Space page</td>
</tr>
<tr>
<td>Printer Consistency</td>
<td>Measurements of patches on rotated page</td>
<td>Measurements of patches on nonrotated page</td>
</tr>
<tr>
<td>Measurement Device</td>
<td>First measurements of patches</td>
<td>Second measurements of the same patches</td>
</tr>
</tbody>
</table>

Click the Results link next to the test name to view detailed test results.

In the detailed test results, click the link to Verifier to view the test data in Verifier.
Generate labels and reports

1 In the detailed test results, do one of the following:
   - To print a label, click Print Label.
   - To create a report, click Create Report.

2 Type the information that you want to appear in the label or report header.

3 If you want to save the information that you entered, click Save Properties and save the file.

4 If you have saved information from a previously generated report that you want to include in this report, click Load Properties and open the file.
   All fields are overwritten with data from the file.

5 Click OK.
   If you are printing a label, a preview of the label appears.

6 Click OK, specify the printer, and click Print.

Set Color Verification Assistant preferences

The Color Verification Assistant tab lets you specify settings for options for Color Verification Assistant.

You can set:
- **Tolerances** - Sets tolerances for the device-specific tests and for other aspects of Color Verification Assistant.
- **CMYK Color Matching and RGB Color Matching** - Set tolerances for the color-specific tests.
- **Auto Verifier** - Configures automatic color test pages on a Fiery Server. See Configure automatic test pages on page 74.

Preferences settings are specific to your user name. If you start Verifier from Color Verification Assistant, your Color Matching preferences transfer to Verifier along with the measurement data.
Set printer and device tolerances

You can set tolerances for Color Verification Assistant printer and measurement device tests. You can also reset notifications in Color Verification Assistant.

- The measurement device test verifies whether the spectrophotometer measures the same value for the same color when you repeat a measurement. The test calculates the average and maximum of the measurement differences. The measurement device test fails if either the average or the maximum of the measurement differences exceeds the specified tolerance.

- The printer test verifies whether the printed output produces the same color when you rotate the test image. The test calculates the average and maximum of the measurement differences for all colors in the color bar. The printer test fails if either the average or the maximum of the measurement differences exceeds the specified tolerance value.

- Color Verification Assistant displays notifications at various times, and you can disable a notification after you view it. Color Verification Assistant preferences allow you to re-enable all notifications.

1. In Color Profiler Suite, click Edit > Preferences.
2. In the Color Verification Assistant tab, click Tolerances.
3. Enter average and maximum dE values in the Measurement device repeatability and Fiery printer repeatability fields.
4. To re-enable all notifications for Color Verification Assistant, click Reset All Notifications.

Set color matching tolerances

You can set tolerances for Color Verification Assistant CMYK and RGB color matching tests.

The CMYK and RGB color matching tests compute the differences between the measured and expected color values with the selected CMYK or RGB source profile and output profile. The tests calculate the average and maximum of the differences for all colors in the color bar as well as the differences for primary and secondary hues and for neutral colors.

1. In Color Profiler Suite, click Edit > Preferences.
2. In the Color Verification Assistant tab, do any of the following:
   - Click CMYK Color Matching and set the CMYK color matching preferences.
     NPDC sets the Neutral Print Density Curve for G7 specification. See the IDEAlliance website.
     dL, dC, dH - Sets differences in luminance, chroma, and hue in HCL color space.
   - Click RGB Color Matching and set the RGB color matching preferences.
Tests in Color Verification Assistant

Color Verification Assistant lets you test the color accuracy that you can expect from the Fiery Server. Color Verification Assistant can generate labels and reports with test summaries.

For each test, you can print the test results in label or report format.

- The label contains a summary of the test results in label format. You can post the label as a status indicator.
- The report contains the complete test results. You can file the report to keep a log of printer performance.

You can also view test results in Verifier, which lets you use Verifier features with the test data. For example, you can save the test data in Verifier.

**CMYK Verification test**

The CMYK Verification test checks how accurately the printed output matches the CMYK source profile.

The test computes the differences between the measured color values and the expected values for the selected CMYK source profile and output profile. A difference greater than the tolerance for the specific test means that the specific test fails.

**Note:** If the Output Profile, Printer Consistency, or Measurement Device test fails, it can cause the CMYK test to fail.

**RGB Verification test**

The RGB Verification test checks how accurately the printed output matches the RGB/Lab source (RGB source profile).

The test computes the differences between the measured color values and the values that would be expected with the selected RGB source profile and output profile. A difference that is greater than the tolerance for the specific test means that the specific test fails.

If the Output Profile, Printer Consistency, or Measurement Device test fails, it can cause the RGB test to fail. Correct any problems and repeat the RGB test.

**Output Profile test**

The Output Profile test computes the differences between the measured color values and the corresponding measurement values contained in output profile. A difference that is greater than the tolerance for the specific test means that the specific test fails.

If the Output Profile test fails, it might be for one of the following reasons:

- The output profile does not match the print job settings (for example, the paper type does not match).
- The paper that the patch page was printed on does not match the output profile.
- The Fiery Server needs to be calibrated.

You can also consider creating a new output profile based on the current state of the printer using Printer Profiler.
Printer Consistency test

The Printer Consistency test verifies whether the printed output produces the same color when the color bar in the test image is rotated. The test compares color measurements read from a page to color measurements read from another page with the same image rotated.

If the Printer Consistency test fails, it affects the accuracy of the CMYK and RGB tests. The Color Matching preferences cannot be tighter than the Printer Repeatability preference. You might try printing a number of copies to warm up the printer and then repeat the test.

You can also consider consulting a service technician to evaluate whether your Printer Repeatability preference is appropriate.

Measurement Device test

The Measurement Device test verifies whether the spectrophotometer measures the same values for the same colors in a color bar when the measurement is repeated. The test compares the color measurements read from two separate measurements of the same page.

If the Measurement Device test fails, the accuracy of all other tests is not reliable. You might consider servicing or replacing the spectrophotometer or adjusting the preference settings for this test. You can also check the spectrophotometer using a diagnostic tool available from efi.com.

Job settings for color matching

Certain print settings in a job generally result in better color matching. If the test results in Color Verification Assistant do not indicate the degree of color matching you want, you might consider changing one of the following print settings. Remember that color matching is only one measure of quality, however, and you might choose to accept less accuracy in order to achieve other goals.

- Rendering Intent (or Rendering Style) - Generally, the Absolute Colorimetric rendering intent results in the best color matching for RGB or Lab colors. However, in this rendering intent, a white background color is printed with toner or ink just as other colors are, instead of allowing the color of the paper to be the background. This simulated white color might appear incorrect to the eye. If this effect is undesirable, use the Relative Colorimetric rendering intent instead.

- Separate RGB/Lab to CMYK Source (or RGB Separation) - Generally, matching of RGB colors is better if this option is disabled (or set to Output) because there is no additional conversion for CMYK simulation.

- Paper Simulation - Generally, matching of CMYK colors is better if this option is on. However, with Paper Simulation, a white background color is printed with toner or ink just as other colors are, instead of allowing the color of the paper to be the background. This simulated white color might appear incorrect to the eye. If this effect is undesirable, turn Paper Simulation off.

  **Note:** Not all types of Fiery Server support the Paper Simulation option. Even in these cases, the best color matching is obtained if you print to a paper with the same white point as the simulated CMYK color space.

- RGB Device Link or CMYK Device Link - If the print settings specify a device link profile, most print settings, including the source profile and output profile, are encapsulated in the device link profile and cannot be changed. Specify optimal settings for Rendering Intent, Separate RGB/Lab to CMYK Source, and Paper Simulation when you create the device link profile.
**Status messages**

Color Verification Assistant posts status messages about the job and the spectrophotometer.

A status message appears in the following situations:

- **If there is an error with the spectrophotometer** - Because Color Verification Assistant is part of Fiery Color Profiler Suite, you must connect a licensed spectrophotometer to your computer to run Color Verification Assistant.

- **If the job is not supported** - Because PCL jobs do not support CMYK color, Color Verification Assistant does not support PCL jobs. (It is difficult to obtain color accuracy using PCL.)

- **If the job needs to be processed** - A copy of the job is processed to determine its specific Output Profile setting before Color Verification Assistant performs its tests. For example, if the selected job is a mixed-media job or if its Output Profile setting is Use Media Defined Profile, the job is processed.

- **If the job contains multiple media** - For a mixed-media job, select the page or page range that has the print settings that you want to evaluate.

  Color Verification Assistant tests only one set of print settings at a time. Selected pages or pages in a page range must all have the same settings. The page selections that you can select from are taken from the job’s Mixed Media settings.

  Different media settings might not produce different test results. For example, if only the page size is different, color is not affected.

**Manage notifications**

A job’s print settings can trigger a notification in Color Verification Assistant. A notification provides additional information that can affect how you interpret test results. You can choose to stop displaying notifications that have already been shown.

If the selected job contains an embedded profile (RGB or CMYK) that the print settings do not override, test results from Color Verification Assistant are not relevant to the job. Color Verification Assistant performs its tests based on the print settings of the job. A job’s print settings do not reflect embedded profiles.

If the CMYK source profile (CMYK simulation profile) is set to None, there is no color management of CMYK objects, although calibration is applied. The output profile is used to determine the expected CMYK measurements.

If the CMYK source profile (CMYK Simulation Profile) is set to ColorWise OFF, there is no color management of CMYK objects and calibration is not applied. No expected CMYK measurements can be calculated, so the test results are unpredictable.

1. In the notification window, select Show only new notifications to prevent the notification from being displayed again.

2. To re-enable all notifications for Color Verification Assistant, go to the Tolerances tab in Color Verification Assistant preferences and click Reset All Notifications.
Print and measure G7 targets

The G7 specification defines standard grayscale curves that can be used to match the output of different printers. G7 calibration adjusts the color output of a printer to the G7 specification, using measurement data from a specific G7 target (patch page). Color Profiler Suite supports printing and measuring P2P25Xa and P2P51Xa targets that are used for G7 calibration. You can measure with any supported measurement instrument.

P2P25Xa and P2P51Xa targets are printed and measured using FieryMeasure, a module of Color Profiler Suite. The resulting measurement data can be used with IDEAlliance Curve or other G7 calibration software.

1. To start FieryMeasure, do one of the following:
   - Windows - Go to the Program Files\Fiery\Applications3\FieryMeasure folder and run the FieryMeasure application.
   - Mac OS - Go to the Applications/Fiery/FieryMeasure folder and run the FieryMeasure application.

2. Select the Fiery Server or Fiery XF Server and click Next.

3. Select the settings for the layout of the patch page and click Print.
   
   For Measure, select G7, and then select the patch set, P2P25Xa or P2P51Xa.

4. Select any job settings for printing the patch page and click OK.
   
   Do not change any color management settings.

5. Retrieve the page from the printer, and follow the on-screen instructions to measure the page.

6. Save the measurements file (.it8) to your computer.
Select a profile

When you are performing a task that requires one or more profiles, you can select standard ICC profiles as well as profiles in locked (.xcc) format in Fiery Color Profiler Suite, as long as you originally created the locked profiles on this computer. You cannot open locked profiles created on other computers.

1  In the Select Profile window, select a location in the From list.
   The Select Profile window displays the profiles that are in the selected location.
   The list groups profiles by class or by color space. Clicking a setting in the Show list limits the list of profiles that appear to a specific profile class or color space.

2  Do one of the following:
   •  Click a profile name in the Profiles area, and click Select.
   •  Click a profile name in the Recently used profiles area, and click Select.

Add and remove locations in the From list

The From list displays predefined locations.

The display depends on the operating system.

-  For Windows, the location name is System. The path for System is WINDOWS\system32\spool\drivers\color.
-  For Mac OS, there are two location names: System and User. The path for System is WINDOWS\system32\spool \drivers\color. The path for User is ~/System/Library/ColorSync/Profiles.

You can also add or remove a local folder, Fiery Server, or Fiery XF server to the From list.

-  Do one of the following:
   •  To add a local folder to the From list, click Open, browse to the folder, click a profile, and then click Open.
   •  To add a Fiery Server to the From list, click Add Fiery and click the Fiery Server.
   •  To add a Fiery XF server to the From list, click Add Fiery XF and click the Fiery XF server. If you find no servers, locate and select the Fiery XF server manually.
   •  To remove a location from the From list, click the location, and then click the minus sign (-).
Unlock a profile in Color Profiler Suite

If Color Profiler Suite is running in licensed mode (not in Demo mode), you can convert a locked (.xcc) profile to the standard ICC format.

This converts the profile to the standard ICC format (the version, 2.0 or 4.0, is not changed) and the new profile replaces the locked profile.

1. In the Select Profile window, click the profile name.
2. Click Unlock Profile.
3. If Unlock Profile does not become active when you select the profile name, confirm that the following conditions are true:
   - Under Profile Information, the profile name has the .xcc extension, indicating that it is in the locked format.
   - Fiery Color Profiler Suite is running in licensed mode (not in Demo mode).
   - The profile was created on this computer.
Rendering intents

An output profile maps out-of-gamut colors to colors in the gamut of the output device. The output profile may also map in-gamut colors to different colors to preserve the relationships between all colors.

There are many ways to map colors, each of which can have different significant effects on output.

The ICC specification defines several ways of mapping colors, called a rendering intent. When you print using a profile, some applications allow you to select the rendering intent that is most appropriate for the images you are printing.

A profile contains data for the following rendering intents:

- **Perceptual** - Preserves tonal relationships in images for perceptually pleasing color. Often used for photographs, including scans and images from stock photography and digital camera images. Typically results in less saturated output than Saturation rendering when printing out-of-gamut colors.

  EFI uses the name Photographic for its implementation of the Perceptual rendering intent. Perceptual (Photographic) selects the Photographic rendering intent for an EFI-supplied profile or the Perceptual rendering intent for other profiles.

- **Saturation** - Creates saturated colors but does not match printed colors precisely to displayed colors. Often used for charts and graphs in presentations. Works well for in-gamut colors in images as well as out-of-gamut colors in presentation graphics.

  EFI uses the name Presentation for its implementation of the Saturation rendering intent. Saturation (Presentation) selects the Presentation rendering intent for an EFI-supplied profile or the Saturation rendering intent for other profiles.

- **Relative Colorimetric** - Attempts to provide an exact color match between source and destination. This rendering intent maps out-of-gamut colors to the nearest in-gamut color. It provides white-point transformation between the source and destination whitepoints. For example, the bluish white color (gray) of a monitor is replaced by paper white. Often used when color matching is important (for example, logo color), even at the expense of tonal relationships.

  Use Relative Colorimetric rather than Absolute Colorimetric intent if you prefer white colors in an image to print as paper white.

- **Absolute Colorimetric** - Is similar to Relative Colorimetric but provides no whitepoint transformation between the source and destination whitepoints. Whites in an image are reproduced as printed color (simulating the destination paper color) rather than replaced by paper white. Best used when you need exact colors, such as for proofing.
Add a Fiery Server

You can add a Fiery Server from the network. You can also add a Fiery Server from the Favorite list.
You will need the DNS name or IP address of the Fiery Server. If you do not have the DNS name or IP address, you can use Search.

- Do one of the following:
  - In the Add Fiery Server window, type the IP address or DNS name for the Fiery Server in the Add a server field and then click OK.
  - In the Add Fiery Server window, click the Fiery Server in the Favorite list, and then click OK.
Add a Fiery XF Server

You can add a Fiery XF server from the network.

You will need the DNS name or IP address of the Fiery XF server. If you do not have the DNS name or IP address, you can use Search to find available Fiery XF servers.

- In the Fiery XF Discovery window, click Manual, type the IP address for the Fiery XF server in the IP Address field, and then click OK.